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SAŽETAK  

Stvaranje fotografije je proces koji počinje snimanjem ili fotografiranjem, a završava razvijenim 

negativom ili pozitivom. U ovom radu se obraĎuju posebne fotografske tehnike i alternativni 

procesi razvijanja fotografija. Analiziraju se fotografske tehnike kroz povijest i mogućnost 

simulacije tih tehnika u danas aktualnim fotografskim sustavima. Zatim se obraĎuju posebne 

fotografske tehnike čije korištenje omogućuje kreativnu izražajnost i korekciju pogrešaka 

nastalih pri primjeni osnovnih tehnika. Ovdje su navedene najvažnije tehnike koje pokazuju 

kako njihova primjena otvara potpuno nove mogućnosti u fotografiji.  

Manipulacijom fotografije u fotografskim laboratorijima, fotografija je dobila novu dimenziju 

prelazeći iz dokumentarne (egzaktne) u ilustrativnu kategoriju. Time se otvorio put manipulaciji 

fotografije kao iskaza. Dolaskom digitalizacije ti isti efekti su više ili manje uspješno simulirani 

na računalu te kroz svoju postupnu remedijaciju otvorili novu dimenziju fotografije.  

Ključne riječi: fotografija, povijesne tehnike, fotografski procesi, digitalna simulacija.  

 

ABSTRACT  

The creation of a photo is a process that starts with shooting or taking photos, and ends with a 

developed negative or positive. In this thesis we have discussed special photographic techniques 

and alternative processes of developing photos. Photographic techniques have been analysed as 

they appeared through the history, as well as the possibility to simulate those techniques in the 

current photographic systems. Afterwards, we elaborated on particular photographic techniques 

whose usage enables a creative expression and correction of mistakes made when applying the 

basic techniques. We have mentioned the most important techniques that show how their usage 

opens a whole new world of possibilities in photography.  

By manipulating a photo in a photo lab, the photography has reached a new dimension passing 

from a documentary (exact) to an illustrative category. That opens a way to manipulation of a 

photo as a statement. With the arrival of digitalization, these effects are more or less successfully 

simulated on the computer and they have, due to their gradual remediation, opened a new 

dimension of photography.  

Key words: photography, historic techniques, photographic processes, digital simulation.  
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1. UVOD 

 

Fotografija kao snimak točnog odraza svijeta nastala je kao stalna čovjekova težnja da 

trajno zabilježi zbivanja, oblike, predmete a i vlastiti lik. Iz te težnje tijekom 19 stoljeća 

razvila se fotografija i vrijedi za drugo najveće otkriće  u tom stoljeću nakon parnog stroja. 

Na svom dugom razvojnom putu od heliografije do današnje digitalne fotografije svjedočila 

je o zbivanju, nečijem postojanju, načinu života, prirodi i ljudima. Kao sredstvo 

komuniciranja postala je nenadoknadiva. Razvoju same fotografije prethodili su povijesni 

fotografski procesi. Ti procesi su od samog početka pratili tehnološki razvoj, sukladno 

njemu se mijenjali i unapređivali. [1] 

Kad se pojavila kao novi medij, fotografija je bez sumnje obnovila vizualne mogućnosti, 

te unijela elemente koji će izazvati nesagledive posljedice u sklopu čitave kulture. Raznim 

tehnikama omogućavala je precizan prikaz stvarnosti i bilježenje raspoloženja i trenutaka. 

Pojavom svjesne manipulacije fotografije, mijenja se njena početna dokumentarna namjena 

te dobiva umjetnički pridjev. Izum fotografije oslobodio je slikarstvo potrebe kopiranja 

stvarnosti, i na taj način fotografija je pridonijela razvoju modernizma. Važno je istaknuti da 

je fotografija odigrala važnu ulogu i u razvoju umjetnosti i dizajna, te svih disciplina u 

kojima je poslužila kao medij izraza.  

U današnje vrijeme sveopće digitalizacije, kad je fotografija dostupna svima te se njom 

bavi veliki broj stručnjaka i amatera. Pojavljuje se želja za fotografijom koja ne služi samo 

za stvaranje dokumentarne uspomene već joj se želi dati ekskluzivni i umjetnički izričaj. 

Prelazeći iz sfere dokumentacije i estetike ona postaje umjetnost. Zbog toga zaljubljenici u 

fotografiju posežu za posebnim fotografskim tehnikama i njihovim simulacijama da bi 

ostvarili tu želju. [1][2] 

 

 

http://hr.wikipedia.org/wiki/Fotografija
http://hr.wikipedia.org/wiki/Slikarstvo
http://hr.wikipedia.org/w/index.php?title=Moderna_umjetnost&action=edit&redlink=1
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2. POVIJESNE FOTOGRAFSKE TEHNIKE I NJIHOVA 

DANAŠNJA SIMULACIJA 

2.1. Kamera obskura 

 

Prvu bilješku o napravi u kojoj kroz rupu nastaje slika nalazimo kod Aristotela u 4. 

st. p.n.e. Kasnije je postala poznata pod imenom camera obscura (termin su prvi upotrijebili 

Talijani, a znači „tamna komora“). [2] 

Najjednostavnije je opisati kao zatvorenu, zamračenu kutiju (ili čak prostoriju) s 

rupicom na jednoj strani. Kroz nju ulazi svjetlost i na suprotnoj plohi ocrtava vjernu obrnutu 

sliku predmeta ispred sebe (Slika 1). 

 

U 16. stoljeću doživjela je svoju prvu praktičnu primjenu i to kao slikarsko 

pomagalo. Za svoje su potrebe slikari konstruirali prenosive camere obscure veličine omanje 

kućice u koju je slikar ulazio kroz otvor na podu. Bila je dovoljno lagana da je mogu ponijeti 

dva čovjeka, a sastojala se od drvenog okvira s platnenim zidovima i od unutrašnje 

prostorije ograđene papirom na kojemu se ocrtavala okrenuta slika. Najkorisnija je bila kod 

crtanja krajolika jer je bilo teško trodimenzionalni prostor prenijeti na papir. 

S vremenom je kamera obskura usavršena dodavanjem leća i zaslona. Dosta je 

popularna bila i boks-kamera 
1
koja je imala promjenljivu žarišnu duljinu

2
 jer se sastojala od 

dviju kutija koje su klizile jedna u drugu. One su često sadržavale i ogledalo koje je bilo 

                                                 
1Prvi fotoaparati koje je konstriao Daguerre, tako da je preuredio cameru obscuru, te u nju smjestito ploču 

osjetljivu na svjetlost. Kombinacijom primitivnih leća sa slabo osjetljivim materijalom za snimanje zahtijevala 

je na jakome sunčanom svjetlu 20 minuta eksponiranja, što se pokazalo kao nedostatak. 

 
2 Žarišna duljina je udaljenost od optičkog centra objektiva do točke u kojoj se skupljaju sve zrake svjetla koje 

dolaze od nekog beskonačnog udaljenog predmeta i paralelno prolaze kroz objektiv. 

Slika 1: kamera obskura 
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postavljeno pod kutom od 45
o
 tako da se svjetlost odbijala i na gornjoj plohi davala sliku 

koja više nije bila obrnuta.  

U 17. i 18. stoljeću kamere obskure su kao pomoćno sredstvo za crtanje bile u 

masovnoj primjeni,  bile su sastavni dio svakoga slikarskog ateljea. Njima su iscrtavane 

konture objekata, povećavali su se i smanjivali crteži itd. Te camere obscure izrađivale su se 

u raznovrsnim oblicima, najčešće u obliku stola, od plemenitoga drva, i bile bogato i 

luksuzno izrađene i ukrašene.  

Iako je kamera opskura jedan od izuma koji su vodili fotografiji, dugo nitko nije ni 

pokušao ustaliti sliku jer su se njome koristili samo za lakšu izradu skice, a nakon toga im 

kao slika više nije trebala. [1][2][3] 

 

 

 

Simulacija kamere obskure 

Da bi se vidjelo kako kamera opskura radi, treba uzeti jedan list papira i probiti 

vrhom olovke malu rupicu u centru, potom papir približiti što bliže oku i gledati kroz rupicu. 

Držati oko do rupice a palac oko 5 cm udaljen od rupice. Može se primijetiti kako se palac 

vidi oštro puno bolje no što se može vidjeti golim okom, a također se primjećuje da je i 

pozadina u čistom fokusu. Odmakom papira sve se vraća na staro. Ovim pokusom se uočava 

da je dubinska oštrina camere obscure beskonačna. 

Kamera obskura (pinhole camera) je jednostavna fotografska kamera koju svatko 

može napraviti kod kuće. Samo ime govori da se radi o kameri koja umjesto modernog 

objektiva ima rupicu probušenu iglom (pinhole). 

Za izradu camere obscure potrebna je kartonska kutija, crni sprej ili crni mat papir, 

igla, deblja folija te fotografski film ili fotografski papir. 

Dimenzije kutije ovise o veličini fotografskog materijala; za film će svakako biti manje nego 

za papir. Unutrašnjost kutije se oboji crnom mat bojom ili se obloži crnim mat papirom da bi 

se smanjile moguće refleksije unutar kutije. Sve moguće spojeve na kutiji potrebno je 

obložiti da ne bi bilo prolaska svjetla nigdje osim kroz rupicu. 
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Rupica se može izbušiti na više načina. Najjednostavniji način je stavljanje poklopca 

od folije na staklo te nježnim okretanjem igle probušiti rupicu. Rupica se ne smije grubo 

probušiti, jer u suprotnom neće ispasti dobra fotografija (Slika 2). Znat će se da je rupica 

dobro izbušena ako se pogledom prema suncu kroz nju vidi spektar boja. 

Na jednoj se strani kutije izreže mala rupa i preko nje se stavi poklopac s izbušenom 

rupicom, te se izolira od svjetla na rubovima. Kao zatvarač može se koristiti komad crnog 

mat papira koji se prilijepi preko rupice. Na suprotnu stranu kutije stavi se fotografski film 

ili papir.  

 

Slika 2: primjer kamere obskure izrađene od kartonske kutije 

Kada se sve ovo napravi kamera je gotova. Jedino što se još mora napraviti je 

izračunati eskpoziciju.
3
  Kako bi se izračunalo vrijeme eksponiranja potrebno je znati kolika 

je blenda
4
 i osjetljivost fotografskog materijala. Blenda se računa prema jednostavnoj 

formuli: 

F=f/d 

gdje je: F – otvor objektiva 

f – žarišna duljina [mm] 

d – promjer rupice [mm] 

Žarišna duljina je udaljenost između rupice i fotografskog papira koja se može lako izmjeriti 

ravnalom. Za promjer rupice potrebno je znati koliko je debela igla. [6] 

 

                                                 
3 Vrijeme eksponiranja je vremensko propuštanje svjetla na film ili senzor 
4 Blenda (eng. aperture) je otvor smješten u objektivu fotoaparata, kontrolira količinu svjetla koje prolazi do 

senzora fotoaparata.  
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2.2. Dagerotipija 

 

Upoznavanje materijala osjetljivih na svjetlo odvijalo se neovisno o cameri obscuri. 

Godine 1727. Johann Heinrich Schulze objavio je rezultate svojih eksperimenata pomoću 

kojih je ustanovio osjetljivost srebrnih soli na svjetlost. On, međutim, nije mogao postići da 

se slika sačuva. Osim toga, nije ni pomišljao na to da osjetljivost srebrnih soli dovede u vezu 

sa stvaranjem slike u cameri obscuri. [1][8] 

  Prvi koji to otkriće primjenjuje na cameru obscuru bio je lončar Thomas Wedgwood. 

Na papir premazan srebrnom soli stavljao je razne predmete i osvjetljavao ih. Dobivenim 

obrisima koristio se za lakše oslikavanje porculana i lončarije, ali nije uspio ustaliti sliku.  

Prva osoba kojoj je to pošlo za rukom bio je Nicephore Niepce. On je staklenu ploču 

premazao judejskim bitumenom
5
. To je fotosenzitivna

6
 tvar koja na svjetlu otvrdne i  

pobijeli, dok se meki, neosvijetljeni dijelovi mogu isprati. Tako je 1826. kositrenu ploču 

prevukao tom kemikalijom i ostavio u aparatu opremljenom meniskus-lećom 
7
i prizmom, 

koja je ispravila bočno projiciranu sliku. Zatim je osam sati ostavio na prozoru radne sobe. 

Tako je uspio proizvesti prvu fotografiju na svijetu “Pogled s prozora kod Le Grasa”  

 

                                                 
5 Asfalt; materijal koji se tada koristio u litografiji 
6 Osjetljivost na svijetlo  
7 Leća kod koje je jedna strana ispupčena a druga udubljena 

Slika 3: Pogled s prozora kod Le Grasa 
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  Od 1829. Niepceu u razvoju heliografije pomaže francuski slikar Louise Daguerre. 

On se već ranije koristio camerom obscurom prilikom slikanja platna za dioramu, pa je 

tražio način da trajno "zamrzne" sliku kako bi ubrzao proizvodnju platna. [2] 

Premda su došli do nekih poboljšanja, kao što je zamjena kositrene ploče srebrnom i neke 

druge izmjene, prije bilo kakvoga značajnog otkrića 1833. Niépce umire. Daguerre nastavlja 

s radom i istraživanjima, te  dolazi do zaključka da je srebrov jodid (dobiven izlaganjem 

srebrnih ploča jodovim parama) sam od sebe osjetljiv na svjetlost, te da ne treba judejski 

bitumen za dobivanje fotografija. Do najvažnijeg otkrića dolazi slučajno 1835. kada je 

osvijetljenu ploču ostavio u kemijskom ormariću, te pogledavši nekoliko dana kasnije, na 

svoje iznenađenje, otkrio da se latentna slika razvila. Daguerre je na kraju zaključio da se 

slika razvila zbog živinih para iz pokvarenoga termometra. To važno otkriće omogućilo je 

da se vrijeme eksponiranja skrati s oko osam sati na pola sata.   

Sliku uspijeva ustaliti tek 1837. godine i to otopinom kuhinjske soli. Svoj postupak je 

nazvao dagerotipija. Degerotipije su bile pozitivi koji se nisu mogli reproducirati, te su bile 

osjetljive i slabo vidljive. [2] [8] 

Uz pomoć suradnika Dominiquea Aragoa, Daguerre je dobio finacijsku pomoć od 

vlade da nastavi s istraživanjima i pokusima. Nakon nekoga vremena u tome je i uspio - 

degerotipija je konačno bila usavršena. Način dobivanja - na srebrnoj ploči, djelovanjem 

jodnih para, nastaje tanka naslaga srebrnoga jodida. Ploča se u fotoaparatu osvijetli, a uz 

pomoć živinih para razvije se tzv. latentna slika, pri čemu živa prianja samo na one površine 

srebrnoga jodida koje su bile više izložene svjetlu. Ploča se fiksirala u natrijevome tiosulfatu 

i zatim sušila nad plamenom. Dobivena se slika stavljala pod staklo da se zaštiti osjetljiva 

površina i spriječi oksidacija srebra. [8] 

Dagerotipija je ipak imala tehnički nedostatak  koji se nije mogao ukloniti: promatrač 

je vidio ili negativnu sliku ili pozitivnu ili kombinaciju obiju, već prema tome iz kojega je 

kuta promatrao dagerotipiju te iz kojega je smjera na nju padala svijetlost. Svaka 

dagerotipija je bila jedinstvena. [2] 
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Simulacija dagerotipije 

Dagerotipija se dobiva pomoću živinih para, grijanje žive je jako opasan posao, a 

dobivene pare mogu biti smrtonosne. 

Za dagerotipiju potrebno je pripremiti bakrenu ploču koja je galvanizacijom premazana 

metalik srebrima i polirana da se sjaji. Metalna ploča se postavi u kutiju otpornu na svijetlo 

(jodirana kutija) koja sadrži jod. U kutiji jodine pare se miješaju sa srebrom, stvarajući sloj 

srebro-jodida osjetljivog na svijetlo čime je obložena ploča. Ploča mijenja nekoliko boja 

tijekom stupnja jodizacije, od svijetlo do tamno žute, ružičaste, plave i zelene boje.  

Na slabijem svijetlu svijeće, postavlja se osjetljiva ploča u kameru te se  izloži subjektu na 

jakom sunčevom svjetlu. Preporuča se start od 1 minute eksponiranja za svaki otvor 

objektiva (npr. ako je f8 = 8 minuta eksponiranja na jakom suncu). Preporučljivo je manje 

vrijeme eksponiranja pri fotografiranju arhitekture, te veća pri fotografiranju stabala i lišća. 

Zatim slijedi razvijanje ploče u kutiji ispunjenoj živinim parama koje su zagrijane na 60°C. 

Tijekom ove faze , živa se stapa sa srebrnim jodidom koji je bio izložen svjetlu. 

Ploča se ispere sa razrijeđenom otopinom natrij-triosulfata i nakon toga vodom. Sjene na 

fotografiji su visoko reflektirajuće polirano srebro, a svjetla mjesta su bijeli amalgami
8
 koji 

rasipaju svjetlo stvoreno pomoću žive, koje je utjecalo na srebro tijekom razvoja. Sušenjem 

ploče ostaje trajni zapis. [6] [13] 

 

 

 

 

 

 

 

 

 

 

 

                                                 
8 Slitina, legura žive s nekom drugom kovinom 
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Anthotipija 

 

Anthotipija je slika stvorena pomoću fotoosjetljivih materijala iz biljaka(slika 4). Ovaj 

proces izumio je John Herschel 1842. godine. Naziv potječe iz grčke riječi antho, što znači 

cvijet. Emulzija je izrađena od zdrobljenih latica cvijeća ili bilo koje druge na svjetlo 

osjetljive biljke, voća ili povrća.  

 

 

Proces je objasnio u svom radu („Royal Society“, 1842. g.) O djelovanju zraka.  

Za dobivanje boja iz cvijeća, obično  je postupao na način da  latice od svježeg cvijeća, odnosno 

one dijelove koji posjeduju jedinstvenu boju,  zgnječi u mramornom tarioniku, same ili uz dodatak 

alkohola, istisnuti sok procijdio kroz čisti lan ili pamučnu krpu. Dobiveni sadržaj je premazivao na 

papir s ravnim kistom, i sušio na zraku bez umjetne topline, ili na blagoj toplini koja izvire uzlaznim 

strujanjem zraka iz Arnott peći. [1][6] 

Najjednostavnije objašnjene Anthotipije je taj, da je to proces koji koristi prirodne pigmente 

bobica, lišća i cvjetova za svoje koloracije. Često puta boja koja se dobije na papiru nije ista onoj 

boje cvijeća a razlog je način na koji određeno cvijeće reagira na UV zrake, kiselost ili lužnatost 

otopine obložene na površini papira. Ovi biljni primjerci  samljeveni u tekuću smjesu , pomiješanu 

s malo denaturiranog alkohola i procijeđeni kroz gazu  služe za dobivanje tekućeg senzibilizatora 

(emulzija). Ovako dobivenom emulzijom obloži se papir, zatim  se osuši i stavi u kontakt s 

dijapozitiv filmom ili nekim objektom (fotogram) na sunčevo svijetlo - često za jako dugo vremena. 

Prosječno vrijeme eksponiranja ovisi o intezitetu sunčevog svijetla, svježini latica cvijeća, 

pojedinom potencijalu boje cvijeta, korištenom papiru te korištenju kiselina i lužina. Općenito 

Slika 4: Anthotipija 
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govoreći, vrijeme eksponiranja može biti kratka (nekoliko sati korištenjem žutih japonica ili 

ciklame), ili duga (nekoliko tjedana korištenjem manje osjetljive biljke).  

Najsvježije cvijeće daje najbolje boje pa je preporučljivo tražiti svježe  vegetacije i latice. 

Latice se mogu osušiti ili ići izravno na izradu rješenja. Najbolja vegetacija, odnosno 

najosjetljivije biljke i voćke uključuju: smrznute borovnice, maline, jagode, repu, žutu 

japonicu (najosjetljiviju na izbjeljivanje), iris, crveni mak (Hersehelov najdraži sastojak), 

špinat, neven, ljubičastu goluždravku, crvenu daliju, i mnoštvo plavog cvijeća. 

Mary Somerville je nastavila eksperimentiranje s anthotipijom i nakon što je Herschel 

ostavio fotografiju da bi prešao na druga područja znanstvenog istraživanja. Istaknula je 

kako se "djelovanje zraka prosječne refrakcije (mogućnosti prelamanja svjetlosti) na povrće 

povećava dodatkom malo sumporne kiseline.“ [6] 

 

Simulacija anthotipije 

 

Postupak izrade anthotipije je vrlo lagan i jednostavan. Svježa ili osušena 

biljka/voćka se izreže na komadiće i samelje pomoću blendera ili tarionika. Dobivena tekuća 

smjesa se pomoću gaze, pamučne krpe ili filtera za kavu procijedi u novu posudu.  

U čisti tekući sok (emulziju) se dodaje par kapi alkohola. Kod tamnijih fotografija 

emulzija je deblja te se dodaje manje vode/alkohola, više a kod „lakših“ fotografija.  

Može se koristiti bilo koji papir koji će održati emulziju, ali budući da stoji na suncu 

nekoliko dana ili tjedana, najbolje je raditi s debelim akvarel papirom. Stražnji dio papira se 

navlaži s spužvom da papir postane mokar (ali ne i da kaplje), zatim se okrene i premaže 

Slika 5: Premazivanje papira  
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emulzijom. Važno je premazati papir dok je vlažan da se izbjegnu potezi kista u konačnoj 

realizaciji (slika 5). 

 

 

Kad se premaz osuši, na papir se stavlja dijapozitiv film (dijapozitivi daju pozitivne,a 

negativi negativne slike) ili neki objekt (fotogram), te se potom „uokviri“ - postavi na ravnu 

površinu i preklopi staklom te kvačicama učvrsti da ne bi došlo do neželjenog pomicanja.  

Okvir se zatim postavi na sunce sve dok se ne dobije potrebna fotografija (fotogram). 

Ovisno o biljci/voću vrijeme eksponiranja može trajati nekoliko sati/dana/tjedana (slika6). 

[12] 

 

 

Slika 6: Eksponiranje papira na sunčeomsvijetlu  
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2.3. Cijanotipija 

 

Cijanotipija je prvi ”jednostavni, potpuni i praktični fotografski proces” u kojem se 

ne koristi srebro. Ovo je otkriće Johnu Herschelu, 1842. godine, omogućilo je trajnu 

pozitivnu sliku u različitim tonovima plave boje. Herschel je izumio cijanotpiju, 

argentotipiju, antotipiju, također je tvorac riječi „positive“, ”negative”, ”photograph”, 

”snapshot”.[10] 

Cijanotipija je najčešće prva tehnika kojom se ulazi u svijet starih fotografskih 

procesa zbog svoje jednostavnosti u tehničkom smislu, ljepote i varijacija. Kao i kod većine 

tehnika, veličina finalne (pozitivne) slike određena je veličinom samog negativa (kontakt 

kopija). Umjesto negativa mogu se koristiti i razni prozirni, polu prozirni i neprozirni 

objekti. Plavi ton je glavna karakteristika cijanotipijske slike(slika 7).  

 

Metoda rada uključivala je običan papir koji bi se senzibilizirao željeznim solima, 

kalijevim fericijanidom i željezo amonij citratom. Rezultat toga je postojana slika, koja 

nakon nekog vremena može izblijediti ukoliko je dugo izložena direktnoj sunčevoj 

svijetlosti. Ukoliko se to dogodi , slika se u potpunosti može „vratiti“ ako se ostavi na 

tamnom mjestu nekoliko dana. Cijanotipija je vjerojatno jedini fotografski proces koji ima 

ovu osobinu. Može se izvoditi na različitim materijalima (papiru, staklu, tkanini, keramici 

itd.), te u kombinaciji sa drugim fotografskim tehnikama. Cijanotipijom se mogu postići 

Slika 6: Cijanotipija  
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odlični rezultati, a korištenjem različitih tonera (kava, čaj...), uvodi se alternativa plavoj boji 

slike.  

U profesionalnim krugovima cijanotipija  se koristila za izradu kopija nacrta i crteža, 

a čak se i danas povremeno koristi. Od intenzivno plave boje koja se dobiva tijekom 

vremena eksponiranja dolazi i naziv „plava kopija“ (blueprint). U izradi pozitiva zahtijeva 

vrlo kontrastne negative, osjetljive su na svjetlo, pa je zbog toga bila pogodna za kopiranje 

nacrta, a ne fotografskih negativa. 

Jedna od prvih  koja je koristila cijanotipiju je Anna Atkins, koja je u listopadu 1843. 

postala prva osoba koja je proizvela fotografski ilustriranu knjigu pomoću cijanotpije. U 

knjizi su se nalaze 424 cijanttipije , a knjiga se zove „"British Algae: Cyanotype 

impressions". Tiskana je privatno i objavljivana je u nekoliko dijelova više od deset godina. 

Njezina knjiga prethodi Talbotovoj „Olovka prirode“ 1844 („Pencil of nature“). [1][6][10] 

 

Simulacija cijanotipije 

 

Cijanotipija se sastoji od dvije jednostavne otopine: 

Otopina A : 10 grama željezo amonij citrat (zeleni) i 50 ml 

vode 

Otopina B : 4 grama kalij fericijanidom i 50 ml vode 

 

Otopine se dobiju otapanjem kemikalija u vodi, sve 

dok se ne otope. Zatim se jednake količine tih dviju otopina 

pomiješaju u novu posudu (slika7). Neiskorištene otopine 

mogu se čuvati odvojeno u zatamnjenim bočicama daleko 

od svjetla, ali trajnost im nije duga. U ovom postupku 

preporučuje se koristiti gumene rukavice. Obična žarulja ili 

žarna nit, sigurna je za korištenje, dok UV svijetlo utječe na fotografije. 

Koristeći kist nanese se dobivena otopina(emulzija) na materijal (papir , karton, 

tekstil ili bilo koji prirodni materijal koji se može koristiti za ispis, kod papira najbolje 

koristiti akvarel papir) (slika 8). Važno je da tijekom premaza, radni prostor bude slabo 

osvijetljen. Nakon što je materijal premazan ostavlja se sušiti u mraku. 

Slika 7: Otopine 
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Kontakt kopijom se postavlja negativ na osušeni senzibilizirani materijal te učvrsti 

staklom(uokviriti). „Okvir“ se izlaže (eksponira) prirodnom sunčevom svijetlu (tradicionalni 

izvor), mogu se koristiti i UV lampe(slika 9).   Također se mogu napraviti i fotogrami, tako 

da se postavi predmet na materijal i zatim izloži sunčevom svijetlu/UV lampama. Vrijeme 

eksponiranja varira, od nekoliko minuta (sunčano nebo) do nekoliko sati (oblačno nebo).  

Kad je papir eksponiran, ispere se u hladnoj vodi par minuta. Ispire se otprilike 5 

minuta, sve dok se ne uklone suvišne kemikalije. U ovom procesu događa se oksidacija koja 

izvlači plavu boju na papir. Ako se želi ubrzat oksidacija, fotografija se postavlja u posudicu 

s vodikovim peroksidom (nakapanjem par kapi vodikovog peroksida (H2O2 ,upotrebljava se 

kao sredstvo za bijeljenje, oksidaciju i dezinfekciju)). Fotografija u trenutku prelazi iz plave 

u tamno plavu boju. Ova akcija služi da se ubrza oksidiranje željeza u par minuta, dok bez 

ove akcije do oksidacije dolazi nakon nekoliko dana. Dobivena fotografija/fotogram se 

osuši. [6][10] 

 
Slika 9: Eksponiranje fotografije  

Slika 8: Premazivanje papira  

http://hr.wikipedia.org/wiki/Oksidacija
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2.5. Kalotipija 

 

 Henry Fox Talbot je 1835. godine snimio prvu trajnu negativ-fotografiju 

koristeći se papirom umočenim u srebrni klorid, fiksiran slanom otopinom. Otkrio je da je 

sol supstanca koja zaustavlja postupak i trajno konzervira sliku od daljnjih promjena. Iako je 

njegov izum bio od velikoga značaja, nije postao popularan. Otkrio je proces kemijskoga 

razvijanja tako da - kad nije uspio dobiti sliku na papiru – ponovno je prevlačio papir 

srebrnim galonitratom, namjeravajući ga ponovno osvijetliti. No, na njegovo veliko 

iznenađenje, na papiru se pojavila slika. Sliku je fiksirao kalijevim bromidom. Usavršavajući 

svoj postupak, Talbot ga je do 1841. toliko unaprijedio da je postao brz kao i Daguerrov, te 

mu je mogao konkurirati. Za razliku od dagerotipije, rezultat kalotipije je bio negativ od 

kojega se moglo proizvesti više pozitiva.  Slike su se mogle dobiti osvjetljavanjem kraćim 

od 30 sekundi. Procesom ponovnoga premazivanja, poput fotogeničnih crteža, mogli su se 

dobiti pozitivi(slika 10). Fox Talbot je ubrzo patentirao svoj proces i nazvao ga kalotipija, 

prema grčkoj riječi kallos, što znači lijep. [1][2] 

Zahvaljujući njegovu otkriću, brzina kalotipijskoga procesa omogućila je 

komercijalno snimanje portreta. Tako su se fotografije izrađene pomoću negativa odlikovale 

jednim karakterističnim svojstvom - mekoćom i toplinom tonova, što je djelomično 

potjecalo od nitaste strukture papira koji je služio kao podloga za negativ. Linije su gubile 

oštre obrise, a detalji su se pomalo rasplinjavali. 

U knjizi „The Pencil of Nature“, koja je tiskana 1844. godine, Talbot je opisao svoj 

proces, kao i to kako je došao na ideju za svoj pronalazak. Godine 1845. objavio je i drugu 

Slika 10: Snijegom prekriveni krajolik, Talbot, oko 1844. godine 
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knjigu, također ilustriranu fotografijama, „Sun Pictures in Scotland“. Sve svoje pronalaske, 

uključujući i knjige ilustrirane fotografijama, zaštitio je patentima. 

Osim Talbotove formule, u godinama nakon njegovog patenta razrađeno je više 

modifikacija osnovnog procesa. Najvažnije su ona iz 1847. godine što ju je pred 

Francuskom akademijom predstavio Louis-Désiré Blanquart-Evrard kao unapređenje 

Talbotovog postupka kalotipije,  te osobito varijacija temeljena na navoštenom papiru 

Gustavea Le Grayja iz 1851. godine, koja je zahtijevala voštenje papira prije nanošenja 

svjetloosjetljivih kemikalija. Njegov negativ proces prozvan je ceroleines ili „LeGray's 

Process“. Pozitivi napravljeni s kvalitetnim papirom ovog negativa imali su odlične rezultate 

i tonske raspone, ali brzo je zamijenjen mokrim negativ pločama. Vosak je složena smjesa te 

se preporučavalo koristiti bijeli umjesto žutog voska. Talbotovi negativi su često bili 

zamrljani i neujednačenih transmisija svjetla, dok je LeGrayev proces voštenja prije same 

obrade  bio bolji. [2] 

Talbot je surađivao i sa znanstvenikom Johnom Hershelom, koji prvi uvodi izraz 

fotografija 1839. godine. Izraz fotografija nastao je spajanjem grčkih riječi  fotos (svjetlo) i 

grafein (crtati). [1] 

 

Simulacija kalotipije 

 

Simulacija kalotipije se izvodi u 2 dijela. 

Prvi dio: 

Za proces kalotipije potrebno je u 200 do 300 ml destilirane vode pomiješati 7,5% 

otopine srebro nitrata (u svakih 100 ml destilirane vode staviti 7.5 g srebro nitrata) sve dok 

se srebro nitrat u potpunosti ne otopi. Dobivena otopina se sprema u bočicu od jantar stakla 

(zbog svoje fotosjetljivosti). Tijekom ovog procesa koriste se rukavice i zaštitne naočale. 

Također se izrađuje 5.5 % otopina kalij jodida (5,5 g kalij jodida u svakih 100 ml destilirane 

vode, te se sprema u bočicu od jantar stakla. 

Na odabranom komadu  papira označava se olovkom površina koja će se 

senzibilizirati. Označena površina se zatim akrilnim kistovima premaže 7,5 % otopinom 

srebro-nitrata i ostavi sušiti. Kad papir postane vlažan, uroni se u otopinu kalij jodida. 
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Ostavi se uronjen oko 2-3 minute, tako da se srebro-nitrat i kalijev-jodid pretvore u srebro-

jodid. Papir će promijeniti boju, iz izvorne bijele do žute. Zatim se papir ispere u destiliranoj 

vodi sat ili dva (s više promjena vode). 

Ispiranjem viška jodida i kalijevog nitrata formiranog tijekom prethodnog koraka, na 

papiru je zadržan srebrni jodid. Nakon sušenja, jodirani je papir senzibiliziran nanošenjem 

otopine srebrnog nitrata te octene i galne kiseline (galo-srebrni nitrat). Ovaj proces se mora 

provesti u vrlo slabo osvjetljenom  prostoru,  koristi se crveno svjetlo ili svjetlo za kukce 

(Talbot je koristio svijeću,ovdje je  najvažnije  izbjeći  plavi kraj spektra). U izvornom 

procesu Talbot je koristio galansku kiselinu , što se kasnije pokazalo da je kemijski 

nepotrebna i zapravo vrlo problematična, jer galna kiselina brzo oksidira i odgovorna je za 

prerano tamnjenje (zamagljivanje) na slici. Eliminacijom te kiseline kalotipija će biti 

uspješnija. 

 

Drugi dio: 

Potrebna je 11,4% otopina srebrnog nitrata (11,4 g srebrnog nitrata u 100 ml 

destilirane vode). U 28 ml dobivene otopine dodaje se 5,5 ml octene kiseline. 

Korištenjem plastičnih kapaljki nakapa se 10ak kapi dobivene otopine u svakih 8 ml 

destilirane vode. Ako se ustanovi da je koncentracija preslaba, jednostavno se smanji 

količina destilirane vode u smjesi. Senzibilizator se primjenjuje na jodiranom papiru na 

onom dijelu koji je prethodno označen olovkom. Premaže se akrilnim kistom ili pamučnom 

četkicom, te se osuši i smjesti 1-2 min u tamnu komoru. Talbot je u izvornom dijelu procesa, 

nakon senzibilizatora umokao  papir u vodu, zatim isprao i osušio. Rekao je kad je papir  

suh, sposoban je za uporabu. Ako je papir bio čuvan u mraku, tvrdio je da se može koristiti  

u fotoaparatu za  3 mjeseca bez značajne razlike u kvaliteti i mogućnosti snimanja slika 

pomoću camere obcure. Ipak nije to uvijek bio slučaj, te je upozoravao da  ga je bolje odmah 

koristi nakon sušenja. Jedan od načina je bio da se papir koristi odmah nakon upijanja 

senzbilizatora, tad se papir koristio u fotoaparatu u vlažnom stanju, a ispis je smanjio izglede 

za maglu ili potamnjivanje papira. 

Ako se kod kalotipije negativa koristi kamera opskura, treba imat beskonačno 

strpljenja i optimizma. Početno vrijeme eksponiranja na sunčanom danu f/8 je oko 2 minute. 

Eksponiranje još vlažnog papira bilo je kraće od vremena za eksponiranje suhog papira, a u 

prosjeku je trajalo od 1 do 10 minuta. 
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Razvijanje negativa se radi u tamnoj komori pod istim uvjetima kao i kod 

senzibilizacije papira i također se koriste sigurnosne rukavice. Nakon eksponiranja, latentna 

slika se razvija u otopini jednakoj onoj korištenoj za senzibilizaciju, a vrijeme razvijanja i 

gustoća negativa ovise o omjeru srebrnog nitrata i octene te galne kiseline. Kako galna 

kiselina nije koristila prije, tako se ne koristi ni kod razvijanja. Umjesto toga pojačava se 

octena kiselina kako bi spriječila zamagljivanje ako je to potrebno. Eksponirani papir se 

polegne na zagrijanu staklenu površinu i lagano kistom premaže otopinom srebrnog nitrata. 

Talbot je u ovom procesu grijao papir kako bi izvukao fotografiju, u današnje vrijeme  često 

se koristi sušilo za kosu  što nije dobra ideja jer će isušiti papir prebrzo. Umjesto toga  

napuni se posuda s toplom vodom i postavi veći dio debelog stakla preko njega. Takvim  

zagrijavanjem  na  negativu se  stvaraju  tamnije vrijednosti. Toplina ubrzava kemijski 

proces i potiče maglu i tamnjenje u kalotpiji, pa je u tom slučaju najbolje izbjeći zagrijavanje 

papira. Ipak razvijanje bez zagrijavanja će trajati duže (do sat vremena) ali će se izbjeći 

magla. 

Nakon razvijanja negativ se ispire u čistoj vodi nekoliko minuta kako bi se uklonila sva 

slobodna srebra prije fiksiranja.  

Negativi su zatim fiksirani upotrebom natrijevog tiosulfata (hipo) (natrij triosulfat  

10% razrijeđen – 100 g natrij triosulfata u 1000 ml vode). Fiksira se na otprilike 4.5 minuta 

ili duže, sve dok žute nijanse nestanu s papira. Ako se još vidi žuta boja  na papiru, to znači 

da je na papiru još uvijek prisutan  srebro jodid. 

Fiksirani papir ispiremo u vodi za otprilike 20-30 minuta, zatim osušimo. Po sušenju 

se nanosi sloj voska radi prozirnosti i osiguravanja kraće vrijeme eksponiranja kod izrade 

pozitiva. 

  Koristi se mekani prozirni vosak  koji se može uspješno nanositi s prstom.  

U papir se lagano utrljava vosak prstima kružnim pokretima da ravnomjerno prekrijemo 

čitavo područje negativ slike. Zatim se pomoću sušila za kosu puše preko površine dok se 

vosak ne otopi i upije u papirna vlakna.  

Druga metoda je također dobra, a ta je da se u papir utrlja biljno ulje dok on ne 

postane proziran. Ulje će uvijek biti dio papira pa u i procesu razvijanja između kalotip 

negativa i senzbiliziranog slanog papira koristi se prozirna folija. Nakon što se na negativ 

nanese vosak, može se koristiti kao kontakt negativ za kompatibilne procese, kao što su slani 
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papir, cyanotipija, albumin  ili se može ponoviti ovaj postupak s novim osjetljivim papirom 

za dobivanje pozitiva kalotipija.  

Potrebno je razlikovati pojam kalotipije od slanog papira. Naime, izraz kalotipija, 

premda predstavlja isključivo negativ fazu Talbotovog procesa, u hrvatskoj se literaturi osim 

za negative na papiru uvriježio također i za pozitive na slanom papiru. Kao što je iz već 

navedenog vidljivo, sam je proces izrade negativa na papiru, premda baziran na Talbotovom 

otkriću, doživio nekoliko modifikacija koje se danas promatraju odvojeno od Talbotovih 

negativa. Pojam kalotipija u slučaju pozitiva je pogrešan i treba ga izbjegavati, te tehniku 

pozitiva odrediti isključivo prema fotografskom procesu kojim je izveden (slani papir, 

albuminska fotografija…), a same negative, koje je iznimno teško razlikovati, nazivati 

jednostavno negativima na papiru. 

Iz negativa na papiru pozitivi su najčešće izrađivani na slanom papiru, a od 1850. godine 

i na albuminskom papiru. [6] 
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2.3.1. Slani papiri 

 

William Henry Fox Talbot i njegova nova 

mladenka Constance, otputovali su na jezero Como 

u Italiji, na medeni mjesec. Dok je tamo bio, 

pokušavao je napraviti pristojan crtež jezera sa 

svojom camerom lucidom 
9
(slika11). [6] 

Talbot, suočen sa svojim posvemašnjim 

nedostatkom talenta za slikanje generirane slike iz 

modela, dosjetio se kako bi to moglo biti šarmantno trajno 

hvatanje slika koje je vidio na usavršeniji način i kako bi 

kad se vrati kući impresionirao svoje prijatelje. Kad se vratio u Englesku, počeo je raditi na 

rješenju  za svoju inspiraciju. 1834. godine osmislio je početke značajnog otkrića. Koristeći 

znanje u eksperimentiranju sa srebro solima od vizionara, kao što su Humphrey Davy, 

Thomas Wedgewood i Carl Wilhelm Scheele, Talbot je nastavio stvarati precizne fotograme 

kontura cvijeća, lišća, perja, čipke , na  slanom i srebro nitratno senzibiliziranom mediju. 

Svoje je otkriće prozvao fotogeničnim crtežima (photogenic drawing). [6] 

 

Simulacija slanog papira 

Promiješa se slana otopina dobivena od natrijev 

klorida 2,0 g s destiliranom vodom 100 ml. 

Prije premazivanja papir se na poleđini 

označi s olovkom kako bi raspoznali nakon što je 

obložen i osušen s koje je strane premazan. Važno 

je da papir ne bude previše proziran jer će imat 

tendenciju da upije previše otopine. Koristeći 

samoljepljive trake rubovi se papira zalijepe na staklo, radi lakše upotrebe. Pomoću kista 

papir se premaže  slanom otopinom, te se osuši (slika 12).  

                                                 
9 Optički uređaj koji umjetniku služi kao pomoć u crtanju  

Slika 12: Premazivanje papira  

Slika 11:camera lucida 
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Nakon što se slani papir osuši pod uvjetima sigurnosnog svjetla, premaže se s srebro-

nitratom. Slani papir je uglavnom osjetljiv na ultraljubičasto svjetlo, a ako se  izloži  niskoj 

razini  svjetlosti žarulja sa žarnom niti neće se magliti. Potreban je veliki oprez da srebro 

nitrat ne dospije na kožu ili, još važnije, u oči 

(moguće je slijepilo). Ako se koristi kist, potrebno je 

koristiti  odvojene  kistove za svaki postupak.  

Također, potrebno je  korištenje papira odvojiti od 

 pipeta  i  štapića za premazivanje. Papir se osuši u 

mraku te je spreman za osvjetljavanje i treba ga 

koristiti odmah kako bi se izbjeglo zamagljivanje. 

Eksponira se na suncu tako da se kontakt-kopijom
10

 negativ kopira na slani papir (slika 13). 

Sunce je najveći izvor svjetla lako dostupan i daje najbolji kontrast. Nedostaci 

korištenja sunčeve svjetlosti  uključuju  varijable
11

 

intenziteta i dugo vrijeme eksponiranja, a kao 

zamjena se može koristiti UV svijetla (slika 14). 

Za optimalne rezultate, potreban je negativ s 

velikim kontrastom. Slani proces može pružiti 

profinjene sjene i jasnije pojedinosti, možda bolje 

nego bilo koji drugi procesi. 

Nakon eksponiranja, fotografija se ispire s vodom. Kako voda iz slavine zna biti vrlo 

alkalna pH oko 8, zna nastati magla. Da bi se to izbjeglo, fotografija se može isprati tako da 

se u pet posudica s vodom stavi 1% limunske kiseline. Fotografija se drži po jednu minutu u 

svakoj posudici.  Nakon ispiranja slane fotografije (ispisi) se moraju temeljito fiksirati. 

Koristi se svježi fiksir otopine 10% natrij triosulfata (Hypo) dodajući 2 grama sode 

birkabone na svaku litru fiksira. Soda birkabona pomaže da se obuzda izbjeljivanje i da 

održi fiksir blago alkalnim. Fiksira se par minuta (4-5min), a zatim ponovo ispere vodom iz 

slavine i osuši. [6][14] 

 

                                                 
10 Izravno kopiranje negative na pozitiv (iste je veličine kao i negativ). 
11 Promjenjiva veličina, promjenjiva vrijednost 

Slika 13: Kontakt-kopija 

Slika 14: UV svijetlo 
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2.3.2. Albumin papir 

 

Eksperimenti s bjelanjkom na staklu prethodili su onome na papiru. Godine 1847. 

francuz Niepce de Saint-Victor objavio je proces koji se sastoji od bjelanjaka na staklu, ali je 

osjetljivost bila niska. Godine 1850 Louis-Désiré Blanquart-Evrard uvodi albumin papir koji 

je korišten kroz skoro cijelo 19. stoljeće. [6] 

Albuminski papir izrađivan je natapanjem jedne strane običnog papira u otopini 

tučenog bjelanjka jajeta (albumin) i natrijevog klorida, nakon čega bi se papir sušio te 

senzibilizirao u otopini srebrnog nitrata. Imali su većinom oštar  i sjajan izgled, za razliku od 

mekih i mat izgleda cijanotipije. Neki mat albumin papiri su napravljeni dodavanjem škroba 

u bjelanjke, ali sjaj bi opet prevladao. Imao je veću izdržljivost površine naspram slanog 

papira. Izrađivali su se komercijalno u rolama od širine 33 inča, spremne za senzibilizaciju 

srebro nitratom od strane korisnika. Bilo je sukobljenih mišljenja o učinkovitosti tih 

materijala – osjetljivost i kvaliteta  bili su važni kriteriji. No senzibilizirani almbumen papir 

nije mogao zadržati svoju osjetljivost za pohranu pa se morao senzibilizirati neposredno 

prije korištenja. Albumin papiri često su bili zlatno tonirani za ublažavanje izbljeđivanja, 

dobivajući karakteristične ljubičasto-smeđe boje. To je tipična boja fotografije 19 stoljeća, 

od kojih je većina (procjenjuje se 90%) albumin papir (slika 15). [7] 

Bio je prvi fotografski papir proizveden 

u velikim količinama. Dagerotipije su bile 

preskupe za masovno tržište, dok je potražnja 

za albumin papir narasla, pa je postalo 

komercijalno moguće uz malo truda skrojiti 

kvalitetan papir za potrebe fotografije. Albumin 

papiri su napravljeni u više od jedne debljine, 

ali većina ih je bila gusta i glatka. [6] 

 

 

Slika 15: Albuminski pozitiv 
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Simulacija albumin pozitiva 

 

Albuminski pozitivi se izrađuju na papiru (100%tni pamuk, akvarel papir), tako da 

ga obložimo emulzijom od bjelanjka (albumin) i soli (natrijev klorid ili amonijev klorid).  

Eumulzija bjelanjka radi se  tako da se u nemetalnu  posudu doda 500 ml bjelanjka (otprilike 

12 jaja,iz kojih se izdvoji bjelanjak) zajedno s 2 ml 28% octene kisleine, 15 ml destilirane 

vode i 15 g amonijevog klorida (kao alternativa može se 

koristiti morska sol) te se sve zajedno miksa (slika 16). 

Električnim mikserom  se smjesa miksa otprilike 30 

minuta. Poslije, dobivena pjenasta smjesa se prekrije 

folijom i ostavi u hladnjaku preko noći. Nakon nekog 

vremena smjesa se slegne, ostavljajući prljavu pjenu na 

vrhu, koja se izvadi i odbaci(slika 17). Pomoću filtera 

preostali bjelanjak (cca 350 ml) se procijedi u staklenku. 

Smjesa se zatim ponovo vrati  u hladnjak za otprilike 

tjedan i tako se dodatno denaturira. 

Na odabrani papir pomoću kista se nanese 

otopina srebro nitrata (15%) koja je osjetljiva na UV 

svjetlo. Drugi način nanošenja je da se papir lagano u 

posudicu s otopinom postavi da lebdi na površin 

(slika 18). 15%-na otopina srebro nitrata se dobije 

tako da se zamiješa 30 g srebro nitrata s 200 ml vode 

pod slabim osvjetljenjem. 

Zatim se papir osuši u odsutnosti UV svijetla. 

Osušeni pripremljeni papir se postavi u izravnom 

kontaktu s negativom te preklopimo staklom. Takav 

negativ se izlaže na  suncu ili UV svjetlu. Neki albumski papiri se eksponiraju  minutu ili 

dvije, dok kod drugih eksponiranje može trajati 15-20 minuta. 

Nakon eksponiranja papir se ispire par minuta, te se fiksira pomoću natrij triosulfata (hypo) 

također par minuta. Opet se ispere i osuši. Toniranjem ovih fotografija poboljšavaj se njihov 

ton i stabilizira fotografija da ne blijedi. Ovisno o toneru toniranje se može izvesti prije ili 

poslije fiksiranja fotografije. [6][11] 

Slika 16: Izrada emulzije 

bjelanjka 

Slika 18: Nanošenje emulzije 

Slika 17: Odstranjivanje 

prljavštine 
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2.4. Mokra ploča 

 

Novi napredak u fotografskoj tehnici bio je kolodij-postupak, što ga je 1851. godine 

javno objavio londonski kipar Frederick Scott Archer. On je u ožujku u časopisu „The 

Chemist“ javnosti predstavio rezultate svojih istraživanja na kojima je radio od 1848. 

godine. Od tada staklo kao podloga postaje kroz više desetljeća dominantno u fotografiji. Za 

kolodijski negativ na staklenoj ploči uvriježio se naziv "mokra ploča", budući da je isti 

zahtijevao trenutačno eksponiranje i tretiranje ploče dok je još bila mokra (slika 19). To je u 

slučaju izlaska iz okvira atelijera iziskivalo nošenje pokretne tamne komore, tako da je ovaj 

postupak za razliku od negativa na papiru bio češće korišten u atelijerskom radu. On je na 

staklene ploče nanosio kolodij s kalijevim jodidom, te ih utapao u otopinu srebrnoga nitrata i 

eksponirao dok bi bile još mokre. Mokre ploče bile su vrlo osjetljive na svjetlo pa su 

omogućavale vrijeme eksponiranja kraće od 3 sekunde. Ploča se odmah nakon eksponiranja 

razvijala u otopini galonitrata i fiksirala u natrijevu tiosulfatu ili kalijevu cijanidu.  Za izradu 

pozitiva na papiru upotrebljavao se papir natopljen otopinom kuhinjske soli, na kojemu se 

slika dobivala direktnim zacrnjivanjem bez razvijanja (slani papir). Kasnije se upotrebljava 

papir tretiran štirkom, albuminom, a tek kasnije želatinom. Postupak na mokroj ploči 

zahtijevao je ne samo fotografsko iskustvo, nego i poznavanje kemije. [2][7]  

Slika 19: Kolodij negativ 
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 Snimanje pomoću mokrih kolodij-ploča ubrzo je postala vladajuća tehnika u fotografiji i 

potpuno zamijenila dagerotipiju, koja je 1860. godine potpuno napuštena. Kolodij-postupak 

imao je dosta nedostataka jer su  ploče morale biti eksponirane u mokrome stanju i odmah se 

razvijale. Budući da je sve to bilo čvrsto vezano za postupak u tamnoj komori, bilo je 

potrebno za snimanje na otvorenome prostoru nositi svu opremu: šator, kutije s pločama, 

hrpe boca itd. [2] 

U to doba nastao je i prvi aparat za povećavanje što ga je konstruirao David Acheson 

Woodward 1857. godine. Aparat se koristio sunčevom svjetlošću i zbog toga su ga prozvali 

solarnom kamerom. Nekoliko godina poslije, 1861., Louis Jules Duboscq je napravio aparat 

za povećavanje koje se koristilo električnim svjetlom. Tako su solarni fotografski aparati 

nestali iz fotografske industrije jer su ih zamijenili aparatima za povećavanje koji su se 

koristili lučnim svjetiljkama. [1] 

 

Kolodij postupak 

 

Otapanjem nitroceluloza u eteru i alkoholu dobije se viskozna tekućina zvana kolodij 

koju prije nanošenja na čistu staklenu ploču treba jodirati. Jodiranje se obavljalo kalijevim 

jodidom otopljenim u alkoholu, nakon čega se jodirani kolodij nanosi na staklenu podlogu 

(slika 20). Takva se ploča sa slojem kolodija uranja u srebrni nitrat čime se na površini 

kolodija i ispod njega stvara svjetloosjetljivi srebrni jodid (slika 21).  

 

Ploča se zatim ulaže u fotografski aparat i eksponira između nekoliko sekundi i 3 

minute, ovisno o svjetlosnim uvjetima, temperaturi i relativnoj vlažnosti zraka (slika 22). 

Dobivena latentna slika treba se razviti dok je kolodij na ploči još mokar. U početku je kao 

razvijač korištena pirogalna kiselina, a nakon 1860. godine najčešće željezni sulfat. 

Slika 20: Nanošenje jodiranog kolodija Slika 21: Posudice s otopinom srebro nitrat 
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Fiksiranje razvijene slike obavlja se natrijevim tiosulfatom ili kalijevim cijanidom, nakon 

čega se ploča ispire, a slika po potrebi pojačava galnom 

kiselinom i srebrnim nitratom kako bi se povećala 

prozirnost.  

Nakon sušenja na kolodij se u svrhu fizičke zaštite i 

sprječavanja oksidacije srebra nanosi sloj prirodne smole 

(sandarak ili šelak). Ograničenost pripreme mokrih ploča 

na mjestu snimanja godinama se pokušavalo nadići 

proizvodnjom tzv. suhe ploče. Suština je bila nanošenje higroskopskog premaza koji bi 

apsorbirao vlagu iz zraka i tako spriječio sušenje kolodija. U tu se svrhu u kolodij dodaje 

med ili pivo te albuminski ili želatinski premazi. Navedene intervencije čine ploče slabije 

osjetljivima, što je rezultira manjom popularnošću i ograničenom upotrebom. Iz kolodijskih 

negativa pozitivi se najčešće postupkom kontaktnog kopiranja izrađuju na albuminskom 

papiru, ali ih je također  moguće izvesti i na slanom papiru, kao i na papirima s kolodijskim i 

želatinskim emulzijama uvedenim u kasnijim desetljećima. [6][7] 

 

Slika 22: Fotografski aparat 
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2.5. Ambrotipija 

 

Kao nusprodukt kolodij postupka nastala je ambrotipija. To su bili tanki negativi na 

staklu izbijeljeni dušičnom kiselinom. Postavljali su se na crnu pozadinu koja bi okretala 

tonove i davala slici izgled pozitiva. Ambrotipija je bila više popularna u Americi, koja se 

pojavljuje od 1854. do oko 1865, a Europi dobiva naziv amphitype (slika 23).   

Fotografi su, naime, primijetili da se negativ, okrene li se strana s emulzijom prema gore, 

pojavljuje ispred tamne pozadine kao pozitiv. Zato su na poleđinu negativa lijepili crnu 

tkaninu ili su je prevlačili crnim lakom. S takvoga negativa nisu se više mogle dobiti 

kontaktne kopije, no kako pozitiv nije ni trebalo izrađivati, kupac je štedio vrijeme i 

novac.[2] 

 

 

 

Slika 23: Ambrotipija 
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2.6. Ferotipija  

 

Pojavom lako dostupne Ambrotipije, godine 

1856. profesor kemije Hannibal L. Smith patentirao je 

još jeftiniji i brži postupak pod nazivom Melainotipija, 

ali se za nju u Europi uvriježio naziv ferotipija, a u 

Americi Tintipija (slika 24). [2] 

Od ferotipije se nisu mogle izrađivati kopije pa 

su se mnogi fotografi koristili posebnim fotoaparatima s 

nekoliko leća, koji su odjednom pravili više snimaka. 

Fotografija se snimala dok je ploča još bila mokra i 

razvijala se odmah, prije nego se ploča osušila. Bile su 

to slike slične ambrotipijama, kod kojih je podloga 

kolodiju, umjesto stakla, bila metalna ploča. Proces se 

odvijao tako da se tanka zacrnjena pločica premazivala mokrim kolodijem. Zacrnjivanje se 

najčešće obavljalo pomoću katrana. Materijal je bio jeftiniji, a metoda dobivanja ferotipije 

brža od tehnike na staklenim pločama. Taj se proces oslanja na činjenicu da negativ 

naslonjen na tamnu podlogu izgleda poput pozitiva. Kako je fotoosjetljiva emulzija bila žute 

boje, fotografije nisu bile dovoljno kontrastne. Oštrina i kvaliteta su im poprilično varirale 

pa su profesionalni studiji izbjegavali korištenje te tehnike, osim za izradu malih fotografija 

za medaljone. Žućkasta emulzija ponekad bi poprimala crvenkaste pa čak  plavkaste i zelene 

tonove dajući pri tome prekrasne efekte. [1][2] 

Ono što je značajno za ferotipiju jest to da je niska cijena metala koji se koristio 

znatno pojeftinila postupak izrade fotografije i time učinila fotografiju dostupnom široj 

populaciji, čime je fotografija prestala biti privilegijom bogatih, pa na ferotipiji često viđamo 

ljude radničkih i seljačkih klasa u opuštenim, spontanim pozama. Na neki način ferotipija 

predstavlja začetak instant fotografije. 

 

Slika 24: Ferotipija 
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Simulacija ferotipije 

Fotografski postupak ferotipije se može simulirati klasičnim fotografskim 

postupkom. Pločicu izrađenu od nekog materijala (željezo, aluminij ili olovo) se dobro očisti 

od prašine i masnoće te se pomoću metalne četke izgrebe tako da se boja što bolje primi. U 

izvornom postupku ferotipije su se zacrnjivale katranom, no danas se mogu koristiti i crna 

emajlirana boja u spreju. Boja se ravnomjerno nanese na cijelu površinu ploče. Nakon toga 

se ploče presvlače fotoosjetljivom emulzijom u tamnoj komori te se nakon toga suše. 

Pri eksponiranju se kosristi kamera opskura ili fotoaparat velikog formata (slika 25). 

Drugi je način da se u tamnoj komori pomoću aparata za osvjetljavanje dijapozitivi 

osvjetljavaju na fotoosjetljive ploče ili da se dijapozitivi većeg formata kontaktno kopiraju 

na ploče. 

Nakon eksponiranja se razvija negativ koji je ujedno i pozitiv. Pločica se provlači 

kroz razvijač, zatim vodenu kupku, fiksir s očvršćivačem i na kraju ispire. Sve tekućine koje 

se koriste za razvijanje moraju biti hladne da se emulzija ne bi isprala sa pločica. Ako je 

temperatura za koji stupanj viša od 20°C, emulzija će samo skliznuti s pločice.  

Nakon ispiranja pločica se suši, a krajnji rezultat je nova ferotipija. [6] 

 

 

 

 
Slika 25: Fotoaparat 

velikog  formata 
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2.7. Suhe ploče 

 

Ograničenost pripreme mokrih ploča na mjestu snimanja godinama se pokušavalo 

nadići proizvodnjom tzv. suhe ploče. Suština je bila nanošenje higroskopskog premaza koji 

bi apsorbirao vlagu iz zraka i tako spriječio sušenje kolodija. U tu se svrhu u kolodij 

dodavao med ili pivo te albuminski ili želatinski premazi. Najpoznatiji od suhih kolodijskih 

procesa uveo je Jean-Marie Taupenot 1856. godine nanoseći na kolodij sloj albumina. Takve 

su ploče davale oštru sliku i mogle su biti čuvane nekoliko tjedana prije upotrebe, ali su 

istovremeno bile slabije osjetljive te ih je trebalo dulje eksponirati. [2] 

 

2.7.1. Albuminski negativi 

 

Albuminski su se negativi pripremali nanošenjem mješavine kalijevog jodida s 

albuminom (bjelanjak jajeta) na potpuno čistu staklenu ploču. Naneseni se premaz sušio, a 

zatim senzibilizirao potapanjem u otopinu srebrnog nitrata, nakon čega je ploča bila spremna 

za eksponiranje. Mogla se eksponirati mokra ili ju je suhu trebalo upotrijebiti kroz sljedećih 

48 sati. Latentna se slika nakon eksponiranja razvijala korištenjem galne kiseline u koju se 

dodavalo nekoliko kapi srebrnog nitrata, zatim fiksirala i sušila. Konačni je rezultat bio 

negativ iznimne finoće detalja, ograničenja zbog kojih nije zaživjela su u prvom redu bila 

delikatnost pripreme ploče i niska osjetljivost. Zbog dugog vremena eksponiranja (između 5 

i 15 minuta), ovaj proces od samog početka ostao ograničen isključivo na snimanje statičnih 

objekata. 

Od ostalih se negativa, izuzev kolodijskih, albuminske ploče razlikuju po relativno 

gruboj ručnoj obradi samog stakla i nesavršenim nanošenjem vezivnog sloja. Boja ovisno o 

korištenom razvijaču najčešće varira od oker narančaste do maslinasto zelene, a na 

vezivnom sloju se mogu primijetiti oštećenja u obliku karakterističnih pukotina albuminskog 

veziva, što omogućuje relativno laku i pouzdanu identifikaciju. Za razliku od kolodijskih 

ploča, na albuminske negative uglavnom nije nanošen zaštitni premaz. [7] 
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2.7.2. Želatinski negativi 

 

Godine 1871. dr. Richard Leach Maddox napravio je fotosenzibilnu suhu ploču s 

emulzijom od želatine, koja je i poslije sušenja zadržavala svoju osjetljivost. Pojava suhih 

ploča omogućila je amatersku fotografiju, jer je fotografski proces postao jednostavniji, te se 

njime mogao svatko baviti. Tako su osamdesetih godina 19. stoljeća ušle u opću upotrebu, a 

kolodij-postupak je ostao samo u grafičkoj, reproducijskoj fotografiji, gdje se dugo zadržao. 

Upotreba želatine omogućila je izradu emulzija, vrijeme eksponiranja kraće od jedne 

sekunde te izradu već gotovih fotografskih ploča spremnih za upotrebu. Ploče tako više nije 

trebalo pripremati neposredno pred snimanje, a zbog higroskopnosti
12

 želatine fotografi su 

dobili mogućnost naknadnog razvijanja negativa po povratku u atelijer. [9][7] 

Želatinske suhe ploče intenzivno su korištene do 1920-ih godina kada ih je istisnuo 

lakši negativ film na nitratnoj podlozi, ali ih se nastavilo koristiti kroz skoro cijelo 20. 

stoljeće u znanstvene svrhe kad je bila izražena potreba za savršeno ravnom i stabilnom 

transparentnom podlogom kao što je staklo. Prve su želatinske ploče bile osjetljive samo na 

plavi i UV dio spektra. Kasnijim uvođenjem ortokromatske emulzije proširile su osjetljivost 

negativa na zeleni i žuti dio spektra, a pankromatske dodatno i na cijeli vidljivi dio spektra 

(slika 26). 

Industrijski pripravljene suhe ploče značile su veliki korak naprijed u fotografiji. 

Fotograf je unaprijed raspolagao pripremljenim negativ materijalom koji je, uvijek spreman 

za snimak, mogao biti eksponiran u najpogodnijemu trenutku i znatno kasnije razvijan. [9] 

                                                 
12 Higroskopnost je svojstvo nekih organskih materijala (duhana, papira) da preuzimaju vlagu iz okoline ili je 

predaju okolini.  

Slika 26: Želatinski negativi 
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2.7.3. Filmovi 

 

Izrada suhih ploča je Georgea Eastmanna 

navela da izradi stroj koji nanosi emulziju na 

staklo, te tako 1881. godine otvara tvrtku The 

Eastmann Dry Plate Company za proizvodnju 

fotografskih materijala (slika 27). Svjestan da 

fotografija neće postati popularnim hobijem dok 

se kao materijal za snimanje ne pojavi nešto 

lagano, jeftino i savitljivo, zamijenio je suhe 

ploče filmovima. Princip smotanoga filma nije 

bio nov, no do tada još nitko nije uspio komercijalno proizvesti takav film, sve dok Eastman 

nije pronašao stroj koji je omogućio masovnu proizvodnju filmova. Eastmanov tzv. američki 

film bio je svitak papira presvučen tankim slojem želatinske 

emulzije koju je nakon razvijanja trebalo odvojiti od 

neprozirne podloge. Tako je nastao transparentan negativ od 

kojega su se zatim mogle izraditi kopije. Godine 1888. 

konstruirao je kameru koja je sadržavala rolu za oko 100 

snimaka, dao joj je ime KODAK
13

 - naziv koji se na svim 

jezicima jednako izgovara. Ime tvrtke Kodak zapravo ne znači 

ništa konkretno. Jednostavno, tražili su kratku riječ koju će 

ljudi  širom svijeta moći lako i točno izgovarati. Nakon 

eksponiranja, razvijanja i fiksiranja, vrpca bi se pritiskala licem 

na staklenu ploču presvučenu slojem kolodija i močila vrućom vodom. Tako omekšana 

želatina prenesena je s papira na staklo, nakon čega su na poleđinu negativa stavljani tanki 

listići želatine ovlaženi vodom i glicerolom te na njih zaštitni sloj kolodija. Postupak 

transfera emulzije s papira na želatinu dovršen je sušenjem. [1][2][9] 

                                                 
13 Kodak broj 1 (slika 28) bila je 17 cm duga i 10 cm široka kutija s određenom vremenskim eksponiranjem od 

1/25 sekunde - dovoljnom da snimi i objekte koji tijekom snimanja nisu potpuno mirovali. Nepomično podešen 

objektiv osiguravao je oštre snimke svih objekata na udaljenosti od 2,50 m ili više. Slike nisu bile pravokutne 

nego okrugle, pa se čitav otvor objektiva koristio za sliku. 

Slika 28: Kodak broj 1 

Slika 27: The Eastmann Dry Plate 

Company 
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Prvi pokušaj da se celuloid, koji je pronašao John Wesley Hyatt, pripremi za podlogu 

fotografske emulzije nije uspio, jer je celuloid bio mutan i neravnomjerno proziran. Tako je 

Eastmann u suradnji s kemičarom Reichenbachom uspio usavršiti celuloidnu traku i od nje 

napravio rol-film koji je omogućavao da se kamere pune na dnevnoj svjetlosti. Osnova za 

proizvodnju celuloida od kojeg su izrađivani filmovi jest celuloza dobivena iz pamučnih 

ostataka. Nitroceluloza se dobivala obrađivanjem tih vlakana dušičnom kiselinom, a moguće 

ju je rastopiti u organskim otopinama i izvesti u formi tankih prozirnih listića. Od 1903. 

godine na pozadinu negativa dodavan je sloj želatine u svrhu poboljšanja stabilnosti i 

sprječavanja savijanja filma. Negativi na nitroceluloznoj podlozi izrađivani su kao plan 

filmovi, filmovi u svitku te za potrebe filmske industrije i to isključivo u standardiziranim 

formatima.  

 

Acetatcelulozni film (poznat i kao sigurnosni film) razvijen je kao zamjena za 

lakozapaljivi nitrocelulozni film krajem 19. stoljeća, no stvarni je prijelaz na novu podlogu 

ozbiljnije započeo tek 1920-ih (slika 29). Kao i kod nitratnih filmova, acetat je dobiven iz 

celuloznih vlakana pamučnih ostataka, ali ne s dušičnom nego octenom kiselinom. Kemijska 

obrada negativa u osnovi se ne razlikuje od obrade nitroceluloznih filmova, uz iznimku 

uvođenja amonijevog tiosulfata (tzv. brzi fiksir) kao fiksira, koji se počeo koristiti 

usporedno s natrijevim tiosulfatom. [7][9] 

Radilo se i na razvoju tehnike koja bi omogućila stvaranje slike u boji. Prvi uspješni 

Slika 29: Acetatcelulozni filmovi 
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eksperiment kojim je proizvedena slika u boji bio je izveden 1861., a izveo ga je fizičar 

James Clerk Maxwell. Ti prvi eksperimenti su se provodili tako da su se koristile tri kamere 

ili bi se činila tri vremenska eksponiranja s filterima u boji. Prvi komercijalni kolor film bio 

je autochrome (1907.), a prvi moderni kolor film je bio kodachrome (1935.) i zasnivao se na 

trima obojenim emulzijama (slika 30). [1][2] 

Upotreba poliestera započela je 1955. godine, najprije u slučajevima koji su 

iziskivali negative na sigurnoj i stabilnoj podlozi (grafička industrija), a tijekom 1960-ih i 

70-ih i kao zamjenska podloga za plan filmove. Pozitivi se izrađuju isključivo na 

želatinskim papirima za razvijanje jednako kao i iz acetatceluloznih negativa 

Razvojem filma u svitku povećao se broj formata. Do danas je najpopularniji 

svakako ostao tzv. leica format veličine 24 x 36 mm, nazvan prema proizvođaču Leica foto 

aparta. Različiti formati, kao što su npr. leica, rol-film, film u svitku i plan-film javljaju se i 

u određenim, različitim veličinama. Najčešće su to veličine 6 x 4,5 cm; 6 x 6 cm; 6 x 7 cm, 6 

x 9 cm, 9 x 12 cm; 10 x 15 cm; 13 x 18 cm itd. Godine 1889. u Parizu su na Prvome 

međunarodnom kongresu o fotografiji, prigodom Svjetske izložbe, dogovoreni su standardi 

fotografskih formata. Osnova standarda postala je Daguerreova ploča, koja je bila veličine 

18 x 24 cm. Iz nje su izvedeni i svi ostali današnji formati pozitiva. [2] 

 

 

Slika 30: Prva fotografija u boji 
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3. POSEBNE TEHNIKE U FOTOGRAFSKOM LABORATORIJU 

 

U ovom poglavlju se govori o klasičnim fotografskim sustavima, konkretno crno-

bijeli negativ-pozitiv sustav. Neovisno o kojem se sustavu radi, tehnički i kreativni dio posla 

započinje snimanjem gdje se odabirom motiva, uvjeta rasvjete, elemenata vremenskog 

eksponiranja, odabirom objektiva, načinom mjerenja svjetla, odabirom rakursa te 

korištenjem različitih filtera bitno određuju karakteristike konačne fotografije. Kod crno-

bijelog negativ-pozitiv sustava poslije snimanja slijedi kemijska obrada filma te nakon toga 

izrada fotografija u fotografskom laboratoriju. Ovaj sustav omogućava da se u svakoj fazi, 

od snimanja, razvijanja filma do izrade same fotografije, može utjecati na konačne 

karakteristike fotografije. Kako je izrada crno bijele fotografije dug proces, često se smatra 

ekskluzivnom. U prijašnjem poglavlju se govorilo o povijesnim tehnikama  dobivanja 

fotografije i mogućnosti simulacija tih tehnika u danas aktualnim fotografskim sustavima, a 

ovdje se govori o posebnim tehnikama izrade u samom fotografskom laboratoriju. 

Prije razrade posebnih tehnika važno je znati „normalni“ proces razvijanja crno-bijelog 

negativa i pozitiva. [5] 

Kod kemijske obrade negativa, film se najprije 

namotava na spiralu u potpunom mraku te stavlja u dozu 

za razvijanje. Nakon što je doza zatvorena, doza 

omogućuje ulijevanje i izlijevanje kemikalija, a 

onemogućuje dolazak svijetla na film, pa se svi daljnji 

procesi obrade filma provode pri „normalnoj“ rasvjeti. 

Zatim se u dozu ulije razvijač (potrebno je paziti na 

temperaturu, vrstu i vrijeme) te ga povremeno 

promiješati. Nakon što se izlije razvijač, nalije se 

prekidač (voda ili voda s dodatkom octene kiseline) koja 

prekida razvijanje i nemogućnost zaostalog razvijač da dođe u fiksir. Nakon par minuta izlije 

se prekidač te se u dozu ulijeva fiksir koji uklanja neosvijetljen halogen srebra s foto 

materijala pretvorbom u brom-natrij. Nakon fiksiranja, fiksir se izlije iz doze te se film 

ispire, a zatim suši (slika 31). [4][5] 

Slika 31: Ispiranje filma 
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Proces izrade pozitiva se odvija pod prigušenim crvenim svijetlom u fotografskom 

laboratoriju (slika 32). Proces je kemijski sličan razvijanju negativa. Pomoću aparata za 

povećanje osvijetli se fotopapir te se stavi u posudicu s razvijačem da se fotografija razvije. 

Razvijač pozitiva reagira s osvijetljenim kristalima srebrne soli, srebro oslobađa njegove 

halogene komponente, ostavljajući mala nepravilna zrna metalnog srebra. Mnoštvo takvih 

zrnaca čini crnu srebrnu sliku (crno ili sivo na slici). Kad se fotografija razvije, vadi se iz 

posudice razvijača i stavlja u posudicu s prekidačem. Prekidač može biti kao i kod negativa 

voda ili voda s dodatkom octene kiseline. Nakon što se fotografija u prekidaču prestala 

razvijati, stavlja se u posudicu s fiksirom par minuta, zatim se ispire u tekućoj vodi. Ovisno 

o vrsti papira, traje od pet minuta do par sati, s time da je prosječno trajanje ispiranja 

dvadesetak minuta. [4] 

 

 

Korištenje posebnih tehnika rada omogućuje kreativnu izražajnost i korekciju 

pogrešaka nastalih pri primjeni osnovnih tehnika. Ovdje su navedene najvažnije tehnike koje 

pokazuju kako njihova primjena otvara potpuno nove mogućnosti u fotografiji. 

 

Slika 32: Fotografski laboratorij 



36 

 

3.1. Retikulacija 

 

Retikulacija je efekt stvaranja mrežaste strukture, tj. nabiranje želatine negativa (slika 

33, 34).  To je posebna laboratorijska tehnika koja se glavnim dijelom provodi pri izradi 

samog negativa ili na gotovom, već razvijenom negativu.  Način na koji se dobije može bit 

uzrokovan hladnim razvijačem iza kojeg odmah slijedi vrući fiksir ili obratno. Većina 

filmova imaju svojstvo otpornosti prema stvaranju mrežaste strukture, ali taj efekt se može 

ponekad proizvesti razvijanjem na temperaturi iznad 40°C. Emulzija na negativu će popucati 

i poćeti se odvajati od podloge ako je negativ izložen naglim promjenama temperature. 

Problem ovog procesa je da se u samom procesu kod razvijanja, retikulira cijeli film.  

Želi li se izraditi jedna fotografija sa filma ili određeni dio, normalnim postupkom se razvije 

negativ te one dijelove koje se žele retikulirati stavi se u posudu u koju se ulije vrela voda. 

Film se drži oko pola minute, zatim izlije vrela voda, te ulije hladna voda (što hladnija, 

približno 0°C ) u kojoj se drži film par minuta . Postupak je moguće ponoviti.  

Također se može stvoriti mrežasta struktura kod tek razvijenih, neotvrdnutih (koristi se 

fiksir bez otvrđivača) negativa sa 10% rastopinom natrij-karbonata. Film se umoči u otopinu 

temperature oko 49°C i pričeka dok se emulzija ne počne nabirati, a zatim se film ispere u 

vodi i osuši. [4][5] 

 

Slika 33: Retikulirani film Slika 34: Povečani prikaz retikulacije 

filma 
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3.2. Bareljef 

 

Bareljef je specijalna tehnika koja mijenja uobičajenu fotografsku sliku u metalni niski 

reljef poput medaljona (slika 35). Najbolji rezultat često se postiže s potpuno oštrim slikama 

i jakim i jednoličnim obrisima.   

Nakon dobivenog crno-bijelog negativa radi se kopiranje negativa na plan film normalne 

gradacije (srednjeg kontrasta). Kopira se tako da se postigne pozitiv  približno 

odgovarajućih tonova tonovima negativa (kontakt kopiranje). Zatimse  razvije  pan film, 

osuši te  slijepi  zajedno sa originalnim negativom. Slijepi se na način da se dijapozitiv (plan 

film) stavi  na negativ (originalni), emulzija  uz emulziju , zatim ih se pomakne tako da 

granice tonova pokazuju uske tamne i svijetle linije. Određivanjem pomaka negativa u 

odnosu na dijapozitiv se postiže željeni efekt.  Dobro se  pričvrste dva plan-filama zajedno 

(slika 36). Umetnu se negativi  između stakala nosača negativa aparata za povećanje. Zatim  

se povećava  i osvijetli foto papir te daljnjim uobičajenim procesom razvija fotografija. 

Preporučuje se papir srednje gradacije. [4][5] 

Slika 35: Bareljef fotografija Slika 36: Pričvršćivanje dva plan filma 
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3.3. Solarizacija 

 

Solarizacija ili Sabattierov efekt je tehnika djelomičnog preobraćanja negativ slike u 

pozitiv putem reeksponiranja neosvijetljenih srebro-halogenida tokom razvijanja (slika 37). 

Kod solarizacije postignuta gustoća zacrnjena na fotografksom materijalu raste 

proporcionalno s povećanjem ukupnog vremenskog eksponiranja.  

Do pojave solarizacije fotografija je tretirana kao strogo realni tehnički zapis bez 

mogućnosti kreativnog djelovanja i stvaranja umjetničke fotografije. Na temelju čega 

zaključujemo da primjenom solarizacije nestaju granice između realnog zapisa i irealnih 

predodžbi.  

Ovu tehniku moguće je provesti i na negativ filmovima i pozitivma. Kako je lakše 

kontrolirati i pratiti solarizaciju kod pozitiva, ona se više primjenjuje nego kod negativ 

filmova. [4][5] 

 

 

 
Slika 37: Crno-bijela fotografija - Solarizirana fotografija 
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3.3.1. Solarizacija pozitiva  

Ovaj postupak solarizacije fotografije na papiru je 

prilično jednostavan, ali zato je teško ponovit taj 

postupak da se dobije isti rezultat. Za dobru 

solarizaciju najbolje je odabrati onu fotografiju koja 

ima oštro iscrtane elemente. Slika mora biti potpuno 

oštra. Kod kemijske obrade filma optimalno je film 

razvit nešto tvrđe.Foto papir (preporuka- zrnatiji papir) 

se eksponira, zatim za pola vremena razvije.  Papir se izvadi iz razvijača te upali bijelo 

svjetlo za reeksponiranje prije drugog djela razvijanja, za oko jednu sekundu. Normalno se 

nastavi razvijati fotografija, potom dovrši razvijanje bez pomicanja papira u posudi.  

Razvijena fotografija se stopira, fiskira i ispere (slika 38). Cijela fotografija izgleda sivo, sa 

nekim preobratnim tonovima i rubnim linijama. Ako se želi mijenjati efekt solarizacije, onda 

treba eksperimentirati  s vremenom osvjetljavanja papira za povećanje bijelim svjetlom. 

[4][5] 

3.3.2. Solarizacija negativ filma 

Ovaj postupak solarizacije negativa omogućuje povećanje na kojem su rubne linije 

mnogo jasnije, njime  se izbjegne sivi izgled čitave fotografije koji karakterizira solarizirana 

povećanja. Može se solarizirati film u fotoaparatu, ali sigurnije i jednostavnije  je raditi iz 

već postojećeg negativa. 

Koristi se umjereno kontrastni negativ plan-film, kao što je ilford grafički film. Napravi 

se kontakt kopija  original negativ filma na plan film. Stavi ga se u posudu sa razvijačem za 

papir i razvija za pola normalnog vremena razvijanja i  pritom trese. Zatim se posuda sa 

razvijačem postavi na temeljnu ploču aparata za povećanje. Film se osvjetljava  u vremenu 

jednakom vremenu eksponiranja za kontaktno kopiranje. Vrati se posuda na stol za 

razvijanje i nastavi  razvijati bez drmanja posude. Što je duže vrijeme osvjetljavanja u 

odnosu na vrijeme eksponiranja slike, to je veći preobratni učinak. Tako se dobiva 

solarizirani pozitiv na filmu.  Nakon što se film osuši, može se napravit negativ kontakt 

kopija da bi mogli pravit fotografije. [4][5] 

Slika 38: Fiksiranje fotografija 
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3.4. Fotogram 

 

Fotogrami predstavljaju način pravljenja slika bez foto aparata. On se isključivo radi u 

foto laboratoriju. Princip je jednostavan –na podlogu foto papira položi se pogodan objekt  a 

zatim upali  svjetlo na aparatu za povećanje da ti objekti naprave svoje sjene (slika 39).  

Nakon razvijanja će se dobit bijeli obrisi tih objekata nasuprot tamnoj pozadini. Ovo je 

najjednostavniji način dobivanja fotograma, a postoje i druge kombinacije kao što je npr. 

fotogrami sa staklom, fotogrami s negativima.  

Fotogrami sa staklom se dobivaju tako da se na papir stavi neki stakleni objekt kao npr. 

čaša za vino. Treba naglasiti  kako je bromidni foto papir j osjetljiv  samo na plavo svjetlo. 

Tako da će se staklo drugih boja reproducirati kao poluprozirno. Umjesto direktnog 

osvjetljavanja može se koristiti i kosi izvor svjetla tako da  se pod kutem od 30 ° osvjetli  

objekt postavljen na podlogu u odnosu na papir. Dobit će se interesantne sjene objekata . 

[4][5] 

 

 

 

 

 

 

 

Slika 39: Fotogram dobiven pomoću škara 
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3.4.1. Fotogrami s negativima  

 

Kod ove se tehnike kombinacijom negativa s objektima se stvaraju zasjenjeni uzorci i 

vizualne mogućnosti su veće. Poželjni su negativi velikog formata. Prva faza je napraviti 

skicu na papiru da bi odredili točne veličine slike, označavanjem obrisa. Zatim  se na papir 

stavi  neki objekt te osvijetli. Sliku se razvije  zadržavajući neznatno svjetlijom no što se 

traži za završni rezultat, zatim se  ispere  i osuši. Ne fiksira se odmah jer je papir još osjetljiv 

na svjetlo što je bitno u daljnjem procesu. Nakon što se osuši, papir se ponovo  postavi  

ispod aparata za povećanje, a zatim  se postavi negativ na mjesto gdje je bio postavljen 

objekt, (dio koji je ostao neosvijetljen ali fotoosjetljiv) (slika 40). Ako je negativ manje 

veličine od objekta koji se osvjetljava  treba dodati neke elemente ili papire da prekriju 

preostali dio jer će u protivnom ti otvori ostati zabilježeni kao crno. Objekti i negativi se 

prekriju staklom i potom osvijetle. Nakon  toga se normalno kemijski obrade (razvijač, stop 

kupka, fiksir, ispiranje). 

Ne mora se nužno objekt za fotogram staviti na papir, može se postaviti na negativ 

pločicu u aparat za povećanje, potom se osvijetli papir. Ova tehnika je ograničena na jako 

male i tanke predmete koji mogu stati u nosač i moraju biti namješteni tako da daju dovoljnu 

oštrinu u dubinu (slika 41). [4][5] 

 

Slika 40: Fotogram s negativom Slika 41: Objekti u nosaču 

negativa 
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3.5. Fotografije pomoću fiksira 

 

Ove fotografije se također rade u samom fotolaboratoriju direktnim kemijskim 

djelovanjem na fotografsku emulziju. Fiksir za fotografije sadrži sastojke koji spriječavaju 

razvijanje srebrnih halogenida, tako da se nakon razvijanja stvara bijeli uzorak  na crnoj 

podlozi (slika 42). 

Postupak je takav da se fiksir pomoću kista ili pritiskom ruke na papir ili filmom velikog 

formata, stvore razni uzorci i obrisi. Zatim se papir stavi u razvijač i upali bijelo svjetlo na 

par sekundi. Sliku se  izvadi čim postigne crni ton. Zatim se normalnim postupkom stopira, 

fiksira, opere i osuši. Pravljenje fotografija fiksirom uvjek rezultira bijelom slikom na crnoj 

pozadini. 

Svakim postupkom razvijač se onečisti i važno je zapamtiti da ga se ne upotrebljava 

ponovno pa se preporuča koristiti male količine kako bi se svaki put koristila svježe 

pripravljena otopina. [4] 

 

 

Slika 42: Fotografija dobivena pomoću fiksira 
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3.6. Raster 

 

Raster je tehnika kojom se više tonska slika pretvara u jednotonsku – „rastersku“(slika 

43). Rasteriranje se postiže tako da se pri eksponiranju negativa na foto papir stavi  

unaprijed rađeni raster. Kod ove se tehnike koristi tvrdi fotografski papir. Kao raster može se  

koristiti gaza koja se stavlja na negativ ili napinje preko foto papira.  

Također se može koristiti raster koji se stavlja na glavni negativ a može se kupiti ili 

napraviti. Teksturirane folije ili rasteri dobivaju se iz podeksponiranih negativa pravilnih 

uzoraka kao što su mat ili polupropusni materijali korišteni u kontaktu sa papirom. Drugi 

način je podeksponirati ultra-osjetljivi film na jednoličan ton (npr. oblačno nebo) da bi 

dobili grubo zrnatu teksturu. [4][5] 

 

 

Slika 43: Original crno-bijela fotografija – Rasterska fotografija dobivena pomoću gaze 
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3.7. Fotografika 

 

Fotografika je tehnika na kojoj dobivena fotografija ima samo dva tona a međutonovi ne 

postoje. Dobije se takozvani jednotonski crtež (slika 44).  

Za dobiti dobru fotografiku treba odabrati motiv jasnih oblika uz što jače svjetlo i što 

manje sjena. Dobiveni film tvrdo se razvije te se kopira na grafički film
14

. Dobiveni rezultat 

je dijapozitiv kojeg se pomoću aparata za povećanje eksponira na tvrdi fotogrsfksi papir. 

Rezultat je fotografika u negativu. Da bi fotografija bila u  pozitivu dobiveni dijapozitiv se 

kontaktno kopira  na istu vrstu grafičkog filma da bi se dobio tvr i negativ. Povećanjem 

njega dobije se fotografika u pozitivu. [4][5] 

 

 

                                                 
14 Grafički film ima ortoemulziju ekstremnog visokog kontrasta. Koristi se večinom za kopiranje ili za 

pretvaranje kontinuiranih tonova slike u liniju. 

Slika 44: Fotografika 
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3.8. Zoomiranje 

 

Zoomiranjem na aparatu za povećanje može se postići efekt da slika na svijetloj pozadini 

izgleda kao da se pomiče prema fotoaparatu (slika 45). 

Fotografija se eksponira za pola potrebnog vremena eksponiranja, zatim se lagano 

podiže aparat za povećanje do vrha i isključi svjetlo. Ovaj efekt fotografije može se dobiti i 

prilikom samog snimanja fotografije pomoću sandwich tehnike
15

. Na isti dio negativa snimi 

se isti motiv uz različite vidne kutove. [5] 

 

 

 

 

                                                 
15 Tehnika nanošenja slojeva 

Slika 45: Original crno-bijela fotografija – Zoomirana fotografija 
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3.9. Maskiranje  

 

Maskiranje je kreativna tehnika u fotografskom 

laboratoriju koja se radi prilikom osvjetljavanja 

fotografskog papira. Dobit će se fotografski papir koji 

je prekriven slikom i ima slobodne površine (slika 46).  

Jedan način maskiranja je onaj koji postoji na 

samom aparatu za povećanje. Sastoji se od 4 šipke koje 

se mogu pomicati lijevo-desno,na maski za negativ,  

zavisi o želji za slobodnim površinama. Rezultat tih 

maski je slika bez oštro određenih rubova, čije se 

granice stapaju s pozadinom. 

Drugi je način, ako se želi postići da slika ima 

drugačiji okvir, taj da se izradi maska za maskiranje pri 

povećanju. Maske se izrađuju od materijala koji ne 

propušta svjetlo, preporučuje se neprozirni karton sa crnom površinom da se izbjegne odsjaj 

svjetla. Pomoću tih maski može se dobiti slika uokvirena na bijeloj ili na crnoj podlozi. U 

prvom slučaju ako se želi fotografija uokvirena na bijeloj podlozi, položi se maska na foto 

papir  na mjesto za  koje se želi da bude bijele boje. Zatim osvijetli i kemijski obradi. Želi li 

se dobiti mekane rubove, maska se  drži par centimetara iznad foto papira i lagano pomiče 

tijekom cijelog vremenskog eksponiranja. Ovaj učinak najbolje djeluje kod objekata s 

jednolično toniranom pozadinom. U drugom slučaju kad  se želi crni okvir na slobodnim 

površinama foto papira. Na temeljnoj ploči aparata za povećanje postavi se foto papir te se 

normalno eksponira. Isključi se aparat za povećanje i na foto papir postavi željena maska na 

onom djelu koji se želi uokviriti. Izvadi se negativ iz nosača te ponovo uključi aparat za 

povećanje za dvostruko vrijeme od vremesnkog eksponiranja. Zatim se papir kemijski 

obradi a dobiveni rezultat je fotografija s crnim okvirom. Želi  li se dobiti mekane rubove, 

sličan princip kao i  u prvom slučaju. 

Ova tehnika se može kombinirat na više različitih načina, tako da maske budu segmenti 

drugih fotografija , te se ova tehnika može kombinirati i s ostalim tehnikama kao toniranje, 

koloriranje. [4][5] 

Slika 46: Maskiranje pri 

povećavanju 
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3.10. Odijeljeno razvijanje specijalne tehnike 

 

Ovom  se tehnikom dobiju  razne vizualne tehnike normalnim postupkom razvijanja. 

Dobivaju se  tako da se  razvijač nanese nejednoličnim raspršivanjem , pomoću vate,  kista 

ili nekog drugog pomagala (slika 47 i 48). Kod nekih tehnika kao što je nanošenje valjkom 

ili rukom, najbolje je koristiti koncentrirani razvijač. Također se razvijač može nanijeti na 

sliku prije eksponiranja. [4] 

 

 

 

 

Slika 48: Razvijanje fotografije 

pomoću špricalice 

Slika 47: Razvijanje 

fotografije pomoću kista 
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3.11. Ručno nanošene fotoemulzije 

 

Fotografiju nije nužno imati na fotografskom papiru, može se izraditi na raznim 

predmetima (drvo, keramika, cigla itd.) nanošenjem fotoemulzije. Već pripravljena 

fotoemulzija može se  kupiti u trgovini, nju treba  samo zagrijati i premazati preko 

određenog objekta. Ako se nanosi na plastiku prethodno se mora presvući poliuretanom, a 

slikarsko platno specijalnom podlogom da ne bi upilo fotoemulziju. Naneseni sloj emulzije 

ostavi se sušiti, te ga se stavi na temeljnu ploču aparata za povećanje, eksponira se te 

normalnim postupkom kemijski obradi (slika 49). [4] 

 

 

Slika 49: Dobivene fotografije na metalnim predmetima 

ručnim nanošenjem fotoemulzije 
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3.12. Retuširanje 

 

Retuširanje se može raditi na pozitivu i negativu. Retuširanje se uvijek odnosi na ručno 

obrađivanje slika, uz upotrebu kista ili olovke da se otklone ili smanje mrlje(nepravilnosti). 

Mnogo se jednostavnije  retuširaju gotovi pozitivi od negativa.  

Kod pozitiva retuširanje se može provoditi i suhim i mokrim retušem. Sjajne površine 

papira je mnogo teže retuširati, jer retuširani dijelovi daju mnogo manji refleks te se najbolji 

retuš provodi na mat fotografskom papiru. Bijele mrlje su najčešći defekt uzrokovan 

zrncima, dlačicama ili ogrebotinama. Uklanjaju se nanošenjem bojila na predmetno 

područje, a to se radi tehnikom mokrog retuša, najčešće točkanjem. Bojila koja se najčešće 

koriste kod mokrog retuša su vodene boje ili boje za retuširanje, a kod suhog retuša se 

koristi odgovarajuća olovka (slika 50). [4][5] 

 

 

 

Slika 50: Retuširanje fotografije pomoću 

tuš olovke 
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3.13. Toniranje  

 

Toniranje je proces izmjene tonova na crno-bijeloj fotografiji ( sivih, crnih) u neki drugi 

ton ili boju (slika 51). Toniranje se može raditi direktno ili indirektno. Direktno toniranje 

daje manje mogućnosti jer se izvodi prilikom samog razvijanja fotografije utjecajem 

razvijača. Indirektno toniranje se više primjenjuje u praksi jer pruža više mogućnosti. Proces 

indirektnog toniranja se sastoji u tome da se kemijski potpuno dovršena fotografija pri 

normalnoj rasvjeti uranja u kemikalije i time se sivi tonovi zamjenjuju bojom. Postoje razni 

toneri i toneri za miješanje kojim se mogu  postići različite kombinacije.  

Proces toniranja može se izvesti na cijeloj fotografiji ili selektivno. Radi se tako da se 

stavi normalno razvijena fotografija u  posudu s izbjeljivačem na vrijeme od 2-3 minuta dok 

crni tonovi ne izblijede do boje isprane slame. Fotografija se izvadi te ispere u hladnoj vodi. 

Potom se fotografija stavi u posudu s otopinom željenog tonera.  Fotografija se nakon 

nekoliko sekundi javlja u odgovarajućim tonovima tonera, ali se mora ostaviti oko 5 minuta 

da se postigne puna dubina. Opere se i osuši na uobičajeni način. 

Selektivno toniranje radi se tako da se izdvoje samo dijelovi fotografije mjestimičnim 

nanošenjem izbjeljivača i tonera kistom, daljnji postupak je isti kao i kod toniranja cijele 

fotografije. [4][5] 

 

 

Slika 51: Tonirana fotografija 
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4. DIGITALNA SIMULACIJA NEKIH POVIJESNIH I POSEBNIH 

FOTOGRAFSKIH TEHNIKA 

 

Gotove fotografije se digitaliziraju da bi se mogle naknadno obraditi i iskoristiti za 

tisak, web ili bilo koje druge ilustracijske potrebe. Digitalizacija se provodi skeniranjem, 

obično u plošnim skenerima pri rezoluciji od 300 dpi ili, ako su predviđena velika 

povećanja, pri rezoluciji od 600 dpi. Dijapozitivi i negativi srednjeg formata se skeniraju pri 

rezoluciji od 600 – 1200 dpi, a dijapozitivi i negativi leica formata se skeniraju pri rezoluciji 

od 4000 dpi. Nakon definiranja veličine, odnosno formata željene skenirane fotografije, 

skenovi se dovode na rezoluciju od 300 dpi. [15] [5] 

Na tržištu postoji mnogo programa za obradu fotografija, no već dugo vremena tu 

drži primat grafički program Adobe Photoshop ili skraćeno Photoshop, razvijen i izdan od 

američke tvrtke Adobe Systems. Uz njega se koriste dodatni i programski paketi. Photoshop 

Elements, Photoshop Express, Photoshop Lightroom. Ovo je trenutno najpoznatiji računalni 

program za obradu slike, te je kompatibilan sa svim značajnijim računalnim platformama 

(Windows, Macintosh). Posljednja inačica ovog programa, Photoshop CS5, je dvanaesta 

generacija istog proizvoda. Velik izbora funkcija omogućava jednostavnu i brzu obradu slika 

kroz razne profile boja (RGB, grayscale, lab, binary bitmap, duotone...). Dopušta 

manipulaciju slikama i stvaranje specijalnih efekata na naprednijoj razini. Moguće je od 

mnogo pojedinačnih slika napraviti složene slike kojima se mogu mijenjati karakteristike i 

po želji ih se uređivati. Zbog velikih mogućnosti Photoshopa pri retuširanju i manipulaciji 

fotografija, u ovom se poglavlju koriste primjeri obrađeni upravo u ovom programu. 

Koristeći više od stotinjak filtera za izradu posebnih efekata s kojima se može dobiti privid 

primjene klasičnih tehnika, svaki filter omogućuje dinamički pregled kroz sučelje koje je 

podijeljeno na module za editiranje slika. Modalitet za editiranje nudi korisniku rafiniranije 

načine rada te omogućava testiranje efekta prije konačne primjene. Na raspolaganju su filteri 

koji dolaze kao sastavni dio programa, te dodatni plugin-ovi, koje koristimo kao vanjske 

module. Nalaze se u mapi Plug-ins te se njihovim dodavanjem Photoshopu može povećati 

funkcionalnost. Neki filteri su i nazvani po klasičnim posebnim.[15] [5] 

http://hr.wikipedia.org/wiki/SAD
http://hr.wikipedia.org/wiki/Adobe_Systems
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4.1. Digitalna simulacija povijesne fotografske tehnike 

 

Pri simuliranju povijesnih fotografskih tehnika  u Photoshopu koristimo sličnu 

digitalnu obradu. Osobine tih „starih“ fotografija su: zatamnjeni rubovi, oštećenja, vinjete, 

ukrasni okviri, različiti formati, slaba oštrina, zrnatost... U ovom poglavlju se govori o 

današnjoj simulaciji povijesnih tehnika u svrhu dobivanja „starinske fotografije“ koja se 

najčešće koristi u dizajnerske i ilustrativne svrhe. Kako danas sve te tehnike izgledaju 

manje-više isto, tako je ovdje pokazan općeniti prikaz simulacije dobivanja „starinskih 

fotografija“. [5] 

Za početak se odabire fotografija koja će se simulirati. Kao najjednostavnije rješenje 

se nameće crno-bijeli negativ-pozitiv sustav, jer je on sam po sebi najbliži povijesnim 

fotografskim tehnikama. S njime se može najbolje manipulirat prilikom snimanja ili u 

samim fazama rada u fotografskom laboratoriju. Dobivena fotografija ili negativ se 

digitalizira pomoću skenera. Drugo rješenje je fotografija dobivena pomoću digitalne 

kamere.  

Odabrana fotografija se otvara u Photoshopu. Prvi korak koji se napravi je da se 

fotografija prebaci u crno-bijeli sustav (Image => Mode => Grayscale). Zatim se dobivena 

fotografija kolorizira. Postoji više načina, a jedan od tih je pomoću akcije Duotone 

(Image=> Mode=> Duotone) (slika 52). Ova akcija nudi više parametara kombinacija boja 

da se dobije karakteristična „sepija“. Boje se postavljaju redosljedom od najtamnije do 

najsvijetlije (najsvjetlija je bijela, koju nije potrebno stavljati u parametre). Ova akcija 

također nudi i gradijentalan prikaz trenutno miješanih boja.  

Drugi način koloriziranja fotografije je pomoću akcije Hue/Saturation, a ona se 

izvodi u RGB ili CMYK sustavu. Sadržaj parametra Hue (označava boju koja vrši 

toniranje), Saturation (označava zasićenost bojom) i Lightness (osvjetljava fotografiju). 

Kombinacijom ovih parametara mogu se dobiti željeni tonovi. Uključivanjem opcije 

Colorize smanjuju se vrijednosti boja na samo jedan ton. Ovu opciju moguće je koristiti 

samo ako se primjenjuje na fotografiji koja je, prije nego što je prebačena u RGB sustav,  

bila u Grayscale sustavu. [15] 
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Kako su kod starih fotografija pozadine (iza motiva) većinom mutne, na odabranoj 

fotografiji se pomoću ručnog označavanja ili Pen toola ocrta kontura motiva. Označi se 

željeni dio fotografije, a zatim se pomoću akcije Inverse obrne selekcija i selektira se 

pozadina. Pozadina se zamućuje pomoću filtera Gaussian blur (Filters=> Blur=> Gaussian 

blur) odabire se naredba za ravnomjerno zamućivanje pozadine gdje se može izabrati 

intenzitet zamućenja (fotografija 53). [15] 

Slika 52: Prebacivanje fotografije u Duotone 

Slika 53:“ Bluranje“ pozadine 
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Kako su fotografije većinom bile neoštre, potrebno je malo zamutiti cijelu 

fotografiju. Filterom Lens Blur (Filters=> Blur=> Lens Blur) će se dobiti željena neoštrina 

(slika 54). [15] 

 

 

Dobivena fotografija se postavi na neku obojenu podlogu, te se pomoću alata za 

brisanje rade nepravilnosti i oštećenja na fotografiji da se dobije osjećaj istrošenosti. 

Također se može napraviti uzorak (pattern) koji će se ponavljati preko fotografije u opciji 

Blending Options (postaviti parametre teksture u  Layers=> Layer Style=> Blending 

Options). Pomoću alata Burn se radi privid oštećene emulzije (slika 55). [15] 

Slika 54: Zamućivanje cijele fotografije 



 

 

55 

 

 

 

Digitalnom simulacijom pojedinih povijesnih tehika mogu se fotografije 

(snimljene nekom od modernih tehnika) obraditi, čime se dobiju vrlo efektne 

ilustracije za potrebe suvremenog dizajna (slika 56, 57). 

 

Slika 55: Oštećivanje fotografije pomoću alata Burn 

Slika 56: Digitalna ne obrađena 

kolor fotografija 

Slika 57: Simulacija „starinske“ 

fotografije 
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4.2. Digitalna simulacija posebnih fotografskih tehnika 

 

Retikulacija 

Retikulacija se u Photoshopu izvodi korištenjem filtera Reticulation (Filter=> 

Sketch=> Reticulation). Promjenljivi parametri prilikom korištenja filtera (gustoća, nivo 

crnog i nivo bijelog) nude veliki broj kombinacija i punu kontrolu postupka, a kvaliteta 

efekta je zadovoljavajuća(slika 58). [15] 

 

 

 

Slika 58: Original crno-bijela fotografija – Retikulacija fotografije 
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Bareljef 

Bareljef u Photoshopu dobivamo korištenjem filtera Emboss (Filter=> Stylize=> 

Emboss). Parametri ovog filtera su: kut reljefa, visina reljefa izražena u pikselima i jačina 

efekta. Jednostavnom  primjenom i promjenljivim parametrima daju vjernu i 

zadovoljavajuću simulaciju posebne fotografske bareljef tehnike (slika 59). [15] 

 

 

 

 

Slika 59: Original crno-bojla fotografija – Bareljef fotografije 
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Solarizacija 

Solarizacija se postiže korištenjem filtera Solarize (Filter => Stylize => Solarize). 

Ovaj filter ima ograničene mogućnosti jer prilikom primjene efekta nema modifikacije 

parametara. Dobiveni efekt može se smanjiti primjenom naredbe Fade (Edit=> Fade 

Solarize). Također se može simulirati modificiranjem tonske krivulje (Image=> 

Adjustments=> Curves) čime se lakše postižu željeni rezultati. 

Dobivenu solariziranu fotografiju je moguće posvijetliti, potamniti, pojačati joj ili 

oslabiti kontrast (slika 60). [15] 

 

 

 

 

 

Slika 60 : Original crno-bijela fotografija – Solarizacija fotografije 
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Raster 

Raterska fotografija se postiže korištenjem filtera Pixelate (Filter=> Pixelate=> 

Color-Halftone). Paramteri ovog filtera su : max. radijus; kanal 1,2,3,4. U parametru max.  

radijus se unosi vrijednost u pikselima za maksimalni radijus polunotnova točaka, od 4 do 

127.  Kod crno-bijelih (grayscale) fotografija koristi se samo kanal 1 u kojem se unose kut 

točaka od prve horizontale (slika 61). [15] 

 

 

 

 

Slika 61 : Original crno-bijela fotografija – Rasterska fotografija 
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Fotografika 

Fotografika se postiže korištenjem naredbe Treshhold (Image=> Adjusments=> 

Treshold). Funkcija Treshold svodi fotografiju na crne i bijele tonove . Za bolje rezultate, 

prije korištenja naredbe Treshhold potrebno koristiti naredbu za modifikaciju svjetline i 

kontrasta (Image=> Adjustmensts=> Brightness/Contrast). Kontrast se postavi na 

maksimalnu vrijednost, čime se svi tonovi na fotografiji svedu na crni i bijeli ton (slika 62). 

[15] 

 

 

 

 

 

Slika 62: Proces dobivanja fotografike u Photoshopu 
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Zoomiranje 

Efekt zoomiranja u Photoshopu se simulira korištenjem slojeva tako da se slika 

multiplicira u nekoliko novih slojeva različite transparencije i različite veličine. Osnovni sloj 

se odabere i duplicira u novi sloj. Novom se sloju smanji prozirnost i poveća se naredbom 

Scale (Edit=> Tranform=> Scale). Slika se multiplicira do željenog broja slojeva i za svaki 

novi sloj se ponavlja ista radnja. Prozirnost sloja se smanjuje, a veličina povećava do te 

mjere da slika u osnovnom sloju ostaje prepoznatljiva i dominantna (slika 63). [15] 

 

 

 

 

   

 

 

 

Slika 63 : Original crno-bijela fotografija – Zoomirana fotogrija 
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Retuširanje 

Photoshop nudi veliku paletu alata i naredbi za retuširanje. Najbitniji je alat Clone 

Stamp Tool koji se nalazi na osnovnoj alatnoj traci programa i omogućuje jednostavno 

prekrivanje pogrešaka i mrlja na fotografiji. Pokazivačem se odabire uzorak za koji se 

pretpostavlja da bi trebao prekrivati mjesto oštećenja te se preslikava preko pogreške. Ovaj 

alat daje mogućnost odabira veličine kopirane površine. Retuširanje Clone Stamp Toolom 

daje odlične rezultate, ali proces može biti dugotrajan. Mrlje i ogrebotine na fotografiji se 

mogu ukloniti i upotrebom filtera Dust & Scratches (Filter => Noise =>Dust & Scratches) 

(slika 64). [15] 

 

 

 

Slika 64: Retuširanje pomoću Clone Stamp alata 
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Toniranje 

Toniranje fotografi je u Photoshopu se provodi naredbom Duotone tj. pretvaranjem 

iz Grayscale modela u Duotone model. U dijaloškom okviru Duotone options parametar 

Type postavlja se na monotone, a željenu se spot boju određuje u okviru color picker iz 

nekog sustava boja (RGB, CMYK, HSB, Cie lab itd.). Odabranu spot boju je moguće 

korigirati tonskom krivuljom (ink - duotone curve). Promjenom parametra Type može se 

stvarati duotone,  trotone ili četverotone. Nakon odabira boje može se u dijaloškom okviru 

Overprint Colors podesiti način miješanja svih boja prilikom tiska (slika 65). [15] 

 

 

 

 

 

 

 

 

 

 

Slika 65 : Original crno-bijela fotografija – Tonirana fotografija  
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Maskiranje 

 

Maskiranje se dobiva tako da se prvo označi dio fotografije koju se želi istaknuti. 

Postoje razni načini označavanja u Photoshopu kao što su označavanje bojom, oblikom, 

ručnim označavanjem itd. Nakon označavanja željenog područja mogu se definirati mekši ili 

oštriji rubovi maske pomoću korisnog alata Refine Edge ( Select => Refine Edge). Ovaj alat 

nudi razne parametre kao što su radijus, kontrast, mekoća, proširenje/suženje označenog 

područja. Nakon što se definiraju parametri, ostali dio fotografije ispuni se željenom bojom 

ili tonom pomoću alata Fill (Edit => Fill) (slika 66). [15] 

 

 

          
 

 

 

 

 

 

Slika 66 : Original crno-bijela fotografija – Maskirana fotografija  
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5. ZAKLJUČAK 

 

Pri poznavanju nekog postupka potrebno je poznavati mnoge procese od njegovog 

početka do samog kraja, tj. sadašnjosti. Ovaj rad nastoji prikazati ljudski pokušaj 

zabilježavanja trenutka kroz razne fotografske tehnike, usput otkrivajući (slučajno ili 

namjerno) raznovrsnosti fotografskih tehnika.  

Fotografija kao postupak, kao radni proces, formirana je na eksperimentalnoj metodi 

na poznatim pretpostavkama ponašanja materije, kemijskim ili električnim putom. Osnovna 

razlika je u tome što u digitalnom fotoaparatu svjetlost apsorbira fotoosjetljivi senzor, dok 

kod klasičnog fotoaparata svjetlost pada na fotoosjetljivi sloj filma. U digitalnom se 

fotoaparatu sve faze nastanka fotografije odvijaju u njemu: snimanje, obrada i pohrana. U 

klasičnom fotoaparatu odvija se samo snimanje, dok se razvijanje i pohrana zbivaju izvan 

njega. 

Digitalnom simulacijom često se uspješno zamjenjuju neki komplicirani i dugotrajni 

postupci klasičnih posebnih fotografskih tehnika koji se koriste u fazama izrade fotografije, 

ali ne mogu u potpunosti zamijeniti sve klasične posebne fotografske tehnike. Efekti 

dobiveni klasičnim posebnim fotografskim tehnikama daju fotografiji drukčiju vrijednost i 

značaj nego efekti dobiveni digitalnom obradom.  

Kombinacijom klasičnih i digitalna tehnika i iskustava, osvježena je fotografska 

praksa. Gotovo zaboravljene tehnike obrade su ponovo oživljene i približene vrlo širokom 

krugu zainteresiranih. Ono što se na početku činilo kao sraz klasične i digitalne fotografije, 

pretvorilo se u savez neslućenih mogućnosti - nudeći nam nove praktične, kreativne i 

zabavne mogućnosti. 
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